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Integration

Section Pass Fail Automated To Do Comments
Integration 13 0 0 3
Target:
Step Test Case Action Verification Type Comment
1 Verify C/C++ EPP Package RC1 RC1 package is no longer available
1.1 Download EPP Package Download, extract and start EPP package EPP Package starts Manual Pass
1.2 Version of Tracing Features Go to Help -> About Eclipse -> Installion Details Verify that all_ tracin_g features and_plug;ip_s_are Manual Pass
1.3 TMF presence Open Tracing perspective Tracing perspective opens Manual Pass
1.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual Pass
1.5 Network Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual Pass
1.6 2022-06 Update Site Go to Help -> Install New Software... -> Update site.  Verify that all LTTng Kernel, LTTng UST and Manual Pass  Uncheck checkbox: "Hide items that are already installed"
2 Verify C/C++ EPP Package RC2
2.1 Download EPP Package Download, extract and start EPP package. Check the It Epp package starts Manual N/A
2.2 Version of Tracing Features Go to Help -> About Eclipse -> Installation Details Verify that qll_ tracir]g featureg and.plug;ip_s_are Manual N/A
2.3  TMF presence Open Tracing perspective Tracing perspective opens Manual N/A
24  LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual N/A
2.5  GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual N/A
2.7  PCAP/PCAPNG presence Open Network perspective Network perspective opens Manual N/A
2.6 2021-09 Update Site Go to Help -> Install New Software... -> Update site.  Verify that all LTTng Kernel, LTTng UST and Manual N/A  Uncheck checkbox: "Hide items that are already installed"
3 Verify C/C++EPP Package RC3
3.1  Download EPP Package Download -extract and-start EPP-package EPP Package starts Manual NIA
3.3  TMFpresence Open-Tracing-perspective Tracing-perspective-opens Manual NFA
3.4  LTTngpresence Open-LTTngKernel-perspective LT Frg-Kernel-perspective Manual N/A
3.5  GDBTracepeintAnalysis-presence Open-GDB-Fraceperspective GDB-Fracepointanalysis-perspective Manual NA
3.6 Network FracepointAnalysispresence  Open-Network Trace-perspective Network Fracepoint-analysis-perspective Manual N/A
3.6 2024-06-Upeate-Site CorloHelp—>lnsiall New Software——>Usethe-  Verify thatallLTing Kemel- LTTng USTand GDB-  Manual N/
4 Verify C/C++ EPP Package RC4
4.1  DewnloadEPP-Package Dewnload-extractand-start EPP-package EPP-Package-starts Manual N/A
. e f .
pFesth—a‘Hd—h‘aVe—t‘he—ee eet Ve Se ( ALY
Version-of FracingFeatures , , , ,
4.2 Geo-to-Help—>About Eclipse—>Instaliation-Details GDBTrace) Manual N/A
4.3  TMFpresence Open Tracing perspective Tracing perspective opens Manual NA
4.4 L TTngpresence Open-LTTng-Kernel-perspective LT Frg-Kernel-perspective Manuat NA
4.5  GDBTracepointAnalysispresence Open-GDB Trace-perspective GDB Tracepeint-analysis-perspective Manual N/A
" t6."2021 06 ; edlinse. " TThaK e ST OB
4.6  2021-06-Update-Site org/staging/2021-06/" Manual NA
5 Verify Update Site
Download Eclipse for Committers and install LTTng
Kernel, LTTng UST, GDBTrace and PCAP Network
Analysis from main simrel testing Update site
"2021-12 - http://download.eclipse.org/releases/2021-
5.1 2021-12 Update Site 12/ Verify that installation was successful Manual Pass
5.2  Trace Compass Update Site Download Eclipse for Committers and install LTTng.  verify that installation was successful Manual Pass



https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
https://dev.eclipse.org/mailman/listinfo/epp-dev
https://dev.eclipse.org/mailman/listinfo/epp-dev
https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
http://download.eclipse.org/staging/2021-06/
http://download.eclipse.org/staging/2021-06/
http://download.eclipse.org/staging/2021-06/
http://download.eclipse.org/staging/2021-06/
http://download.eclipse.org/staging/2021-06/
http://download.eclipse.org/staging/2021-06/
https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
https://download.eclipse.org/releases/2021-12/
http://download.eclipse.org/tracecompas/2021-12/milestones/rc2
http://download.eclipse.org/tracecompas/2021-12/milestones/rc2
http://download.eclipse.org/tracecompas/2021-12/milestones/rc2
http://download.eclipse.org/tracecompas/2021-12/milestones/rc2
http://download.eclipse.org/tracecompas/2021-12/milestones/rc2
http://download.eclipse.org/tracecompas/2021-12/milestones/rc2

5.3
5.4
5.5

6.1
6.2

Upgrade using 2021-12 Update Site
Upgrade using Trace Compass Update
L-Jbragde from previous EPP

Verify Update Site

Trace Compass update site
Upgrade using Trace Compass update

Download Eclipse for Committers from 2021-09 and

Download Ecli-p_s_e for Committers from 2021-03 and

Download Eclig_se Qré(/ious' C/C++EPP package. Try

Release outside release train

Download Eclipse standard and install LTTng Kernel

Download Eclipsg_standard from Photon SRO and

Verify that installation was successful
Verify that installation was successful
Verify that installation was successful

Verify that installation was successful
Verify that installation was successful

Manual
Manual
Manual

Manual
Manual

Integration


http://download.eclipse.org/releases/2021-09
http://download.eclipse.org/releases/2021-09
http://download.eclipse.org/releases/2021-09
http://download.eclipse.org/releases/2021-09
http://download.eclipse.org/releases/2021-09
http://download.eclipse.org/releases/2021-09
http://download.eclipse.org/releases/2021-09
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
http://download.eclipse.org/tracecompass/releases/7.2.0/repository
https://download.eclipse.org/releases/2021-12
https://download.eclipse.org/releases/2021-12
https://download.eclipse.org/releases/2021-12
https://download.eclipse.org/releases/2021-12
https://download.eclipse.org/releases/2021-12
https://download.eclipse.org/releases/2021-12
http://download.eclipse.org/tracecompass/stable/repository/
http://download.eclipse.org/tracecompass/stable/repository/
http://download.eclipse.org/tracecompass/stable/repository/
http://download.eclipse.org/tracecompass/stable/repository/
http://download.eclipse.org/tracecompass/stable/repository/
http://download.eclipse.org/tracecompass/stable/repository/
https://download.eclipse.org/tracecompass/stable/repository/
https://download.eclipse.org/tracecompass/stable/repository/
https://download.eclipse.org/tracecompass/stable/repository/
https://download.eclipse.org/tracecompass/stable/repository/
https://download.eclipse.org/tracecompass/stable/repository/
https://download.eclipse.org/tracecompass/stable/repository/

ColorsView

Target:

Section
TMF - Colors View

Step Test Case

N —

AW

o O

Open a test trace
Open the colors view

Select a color and a filter
Add multiple colors
Change the color
priorities

Delete all the colors

Action

Atrace is visible in the events editor

The view is visible

Select a color and a filter, the matching events should update
their colors (background and foreground) to the new ones
Click on add 4 times, four colors should be displayed

By clicking on up and down, the order of the displayed colors
should change

The color filters should disappear.

Fail

Verification

SWTBot
SWTBot

SWTBot
SWTBot

SWTBot
SWTBot

Automated To Do Comments

6 0
Type
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass

Comment



ProjectView

Section Pass Fail Automated To Do Comments
TMF - Project View [ 104 [ o J2
Target: Windows

Step Test Case Action Verification Type Comment
1 Preparation
11 Step 1 Open LTTng Kernel perspective LTTng perspective opens with correct views ~ SWTBot
12 Step2 Open Project Explorer Project Explorer opens SWTBot

2 Project Creation

21 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens SWTBot

2.2 Create project Specify a project name and finish Tracing project appears in Project Explorer SWTBot

2.3  Project structure Open the new Tracing project Project contains Experiments and Traces SWTBot
3 Traces Folder

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import Custom Text and XML parsers

( ustomXi xml
ExampleCustomTxtParser.xml) from
directory traces/customParsers into your
workspace from the Manage Custom Parsers

Preparation dialog. SWTBot
3.1 Traces Folder menu Select the Traces folder and open its context Correct menu opens (Import, Refresh) SWTBot
3.2 Trace Import Wizard Select Import Trace Import Wizard appears SWTBot

1) Browse to directory ${local}/traces/import/
2) Select trace ExampleCustomTxt.log

3) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite

existing without warning" and select "Create Imported trace appear in Traces Folder and
Import single custom text trace Links to workspace" and the Trace Type Tmf Generic is set. Make
3.3  (link to workspace) 4) press Finish sure trace can be opened SWTBot
Imported trace appear in Traces Folder and
Import Single custom XML trace  redo 3.1-3.3 but this time select the Trace Type "Custom XML log" is set.
3.4  (link to workspace) ExampleCustomXml.xml Make sure that trace can be opened SWTBot

Imported trace appear in Traces Folder and
Import LTTng Kernel CTF trace redo 3.1-3.3 but this time select directory kernel- the Trace Type "LTTng Kernel" is set. Make

3.5 (link to workspace) overlap-testing/ sure that trace can be opened SWTBot
redo 3.3, 3.4, 3.5. However, Unselect "Create
Links to workspace" Traces are imported with new name that has
a suffix (2) at the end. Make sure that
3.6 Rename + copy import When dialog box appear select Rename imported traces are copied to the project. SWTBot
redo 3.3, 3.4, 3.5. However, Unselect "Create Existing traces are deleted and new traces
Links to workspace" are imported. Make sure that imported
traces are copied to the project and can be
3.7 Overwrite + copy import When dialog box appear select Overwrite opened SWTBot

redo 3.3, 3.4, 3.5. However, Unselect "Create
Links to workspace"

3.8  Skip When dialog box appear select Skip Make sure that no new trace is imported SWTBot
redo 3.3, 3.4, 3.5. However, Unselect "Create ~ Make sure that no dialog box appears (for
Links to workspace" and select "Overwrite renaming, overwriting, skipping) and existing

3.9  Default overwrite existing without warning" traces are overwritten). Make sure trace can  gwTBot

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import
3) Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import

unrecognized traces", unselect "Overwrite unrecognized.log is imported with trace type
existing without warning" and select "Create unknown. The default text file icon is
Links to workspace" and displayed. The trace, when opened, is
3.10  Import unrecognized 5) nress Finish displayed in the text editor. SWTBot no trace drawn in the charts just a text appeared in the text editor
redo 3.10, however unselect "Import
3.11  Import unrecognized (ignore) unrecognized traces” unrecognized.log is not imported SWTBot
Delete all traces in project - Right mouse
Preparation click on Traces folder and select "Clear" SWTBot
Imported trace appear in Traces Folder and
Import CTF trace by selection Redo 3.5, However only select metadata file the Trace Type "LTTng Kernel" is set. Make
3.12 metadata file only instead of directory trace sure that trace can be opened SWTBot
Preparation Delete all traces in project



3.13

3.14

3.15

3.16

3.17

3.18

3.19

Recursive import with auto-
detection (Rename All)
Preparation

Recursive import with auto-
detection (Overwrite All)
Preparation

Recursive import with auto-
detection (Skip All)
Preparation

Recursive import with auto-

detection (test rename, overwrite

and skip)
Preparation

Recursive import with specific
trace type 1 (Skip All)
Preparation

Recursive import with specific
trace type 2 (Skip All)

Preparation

Recursive import with specific
trace type 3 (Skip All)
Preparation

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import
3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite

existing without warning", select "Create Links to

workspace" and unselect "Preserve Folder
Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite

existing without warning", select "Create Links to

workspace" and unselect "Preserve Folder
Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite
existing without warning" and select "Create
Links to workspace" and uncheck "preserve
folder structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite

existing without warning", select "Create Links to

workspace" and unselect "Preserve Folder
Structure”

5) press Finish

6) When dialog appears select "Rename”

7) When dialog appears select "Overwrite"
Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Generic CTF Trace",
Select "Import unrecognized traces", unselect
"Overwrite existing without warning”, select
"Create Links to workspace" and unselect
"Preserve Folder Structure"and

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "LTTng Kernel Trace",
Select "Import unrecognized traces", unselect
"Overwrite existing without warning", select
"Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "LTTng UST Trace", Select

"Import unrecognized traces", unselect
"Overwrite existing without warning", select
"Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

Delete all traces in project

All Traces are imported with respective trace
type set. Traces with name clashes are
imported with suffix (2). 1 trace
(unrecognized.log) is imported with trace
type unknown. Make sure that traces can be
opened which have a trace type set. The
unknown trace type should open with the
text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are
overwritten . 1 trace (unrecognized.log) is
imported with trace type unknown. Make
sure that traces can be opened which have
a trace type set. The unknown trace type
should open with the text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are not
imported. 1 trace (unrecognized.log) is
imported with trace type unknown. The
unknown trace type should open with the
text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are
either renamed, overwritten or skipped as
per dialog action. Make sure that traces can
be opened which have trace type set. The
unknown trace type should open with the
text editor.

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

4 CTF traces are imported with trace type
"Generic CTF Trace" . Make sure that these
traces can be opened

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

One LTTng Kernel trace is imported with
trace type "LTTng Kernel Trace". Make sure
that this trace can be opened.

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace
type "LTTng UST Trace". Make sure that
these traces can be opened.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

ProjectView



3.20

3.21

3.22

3.23

3.24

3.25

3.26

3.27
3.28

3.29

3.30

3.31

3.32

3.33

Recursive import with specific
trace type 4 (Skip All)
Preparation

Import wizard from workbench
menu with project selected

Import wizard from workbench
menu with no project selected
Preparation

Drag and Drop from other Tracing
project

Drag and Drop from non-Tracing
project

Drag and Drop from external

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)
Import destination
Preparation

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

Recursive import with preserved
folder structure (Rename All)
Preparation

Delete with mixed selection of
traces and folders

Delete multiple folders

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Tmf Generic", Select
"Import unrecognized traces", unselect
"Overwrite existing without warning", select
"Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

Delete all traces in project

1) Select project "Test" in Project Explorer view

2) Open import wizard from menu File > Import...

1) Clear selection in Project Explorer view

2) Open import wizard from menu File > Import...

Delete all traces in project
D&D a few LTTng traces from another Tracing
project's Traces folder

D&D a few files from a non-Tracing project

D&D a few files from an external file manager
1) D&D a trace with name of an existing trace
into traces folder

2) Confirm the renaming of traces

Redo test 3.26 with the same trace and same
destination folder

Open Import wizard

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select
"Create Links to workspace" and select
"Preserve Folder Structure”

5) press Finish

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select
"Create Links to workspace" and select
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Skip All"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning”, select
"Create Links to workspace" and select
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Rename All"
Delete all traces in project

1) Create two trace folders under the "Traces"
folder

2) Import 2 traces under each folder

3) Open all 4 traces

4) Select one trace in the first folder and the
second folder in the Project Explorer view

5) Right-click, Delete. Click Yes.

1) Create 2 trace folders under the "Traces"
folder

2) Import a trace under each folder

3) Open both traces

4) Select both folders in the Project Explorer
view

5) Right-click, Delete. Click Yes

All text files in directories are imported as
trace and trace type "Tmf Generic" is set.
Note that trace type validation only checks
for file exists and that file is not a directory.
Make sure that these traces can be opened.
However traces with wrong trace type won't
show any events in the table.

Verify that trace is imported to "Test" project
and can be opened.

Verify that trace is imported to default
"Tracing" project and can be opened.

Selected traces are added to Traces folder
with proper icon. Trace can be opened.
Selected traces are added to the Traces
folder with default icon. Files can be opened
with the default editor.

Selected traces are added to the Traces
folder with default icon. For actual traces,
Trace type is detected automatically. Trace
can be opened. For non traces the files are
added with default icon and they can be
opened with the default editor.

Verify that trace is added into the traces
folder with the trace name of the original
trace plus a suffix (2)

Verify that trace is added into the traces
folder with the trace name of the original
trace plus a suffix (3)

Verify "Into Folder" box cannot be updated

All Traces are imported with respective trace
type set. The folder "clashes" is imported
with its traces inside. Make sure that traces
can be opened which have a trace type set.

The wizard should finish quickly as no trace
will be imported. Make sure that traces can
be opened which have a trace type set.

All Traces are imported with respective trace
type set with suffix (2). The folder "clashes"
is imported with its traces inside. Make sure
that traces can be opened which have a
trace type set.

A dialog should ask the user to confirm
deletion of the selected elements. Clicking
OK should remove all that was selected.
The editor of the 3 deleted traces should be
closed automatically with one remaining
editor opened.

A dialog should ask the user to confirm
deletion of the selected elements. Clicking
OK should remove all that was selected.
The editor of both traces should be closed
automatically.

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual
Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

https://bugs.eclipse. bug.cqi?id=576612

When dragging under Tracing project root, icons look like defaults.

When dragging under Traces folder, icons and Views become standard tracing ones.

Similar to above.

What do you mean? The into folder text should be greyed out

ProjectView


https://bugs.eclipse.org/bugs/show_bug.cgi?id=576612

3.34

3.35

3.36

3.37

3.38

3.39

3.40

3.41

4.1
42
43
44
45
46
47

4.8

4.9

Clear single Traces folder

Clear multiple Traces folder

Preparation

Import from zip archive, preserve
folder structure

Preparation

Import from zip archive, no
preserve folder structure

Preparation

Import from zip archive specific
traces
Preparation

Import from tar.gz archive,
preserve folder structure

Preparation

Import from tar.gz archive, no
preserve folder structure

Preparation

Import from tar.gz archive specific
traces

Trace

Trace menu

Open trace

Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)

Open Trace (double click)

Open Trace (already open)

1) Import 2 traces from different folders
preserving folder structure

2 Open both traces.

3 Select the Traces folder

4) Right-click, Clear. Click Yes.

1) Import 2 traces to different projects

2 Open both traces.

3 Select both Traces folders

4) Right-click, Clear. Click Yes.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect
"Overwrite existing without warning" and select
"Preserve Folder Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect
"Overwrite existing without warning" and
unselect "Preserve Folder Structure”

5) press Finish

6) Select Rename All when dialog comes up.
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select file "z-clashes/ExampleCustomTxt.txt"
and folder "kernel-overlap-testing"

4) Select trace type "Automatic”, and select
"Preserve Folder Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect
"Overwrite existing without warning" and select
"Preserve Folder Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect
"Overwrite existing without warning" and
unselect "Preserve Folder Structure"

5) press Finish

6) Select Rename All when dialog comes up.
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select file "z-clashes/ExampleCustomTxt.txt"
and folder "kernel-overlap-testing"

4) Select trace type "Automatic”, and select
"Preserve Folder Structure”

5) press Finish

Select an LTTng trace and open its context
Select the Open menu

Select the Copy menu and provide a new name.
Select the Rename menu and provide a new
Select the Delete menu and confirm deletion
Select trace and press Enter

Select trace and press Delete and confirm

Double-click a trace

Open two traces. Open the first trace again.

A dialog should ask the user to confirm
clearing of the folder. Clicking Yes should
remove everything under the selected folder
and close the traces

A dialog should ask the user to confirm
clearing of the folders. Clicking Yes should
remove everything under the selected
folders and close the traces

All the files get imported under their
respective folders. The CTF traces can be
opened (kernel-overlap-testing,
simple_server...)

Al traces are imported with trace type set.
The traces from folder "clashes" are
renamed with suffix (2). Make sure that the
traces can be opened

The specified traces are imported with trace
type set. Make sure that the traces can be
opened.

Al the files get imported under their
respective folders. The CTF traces can be
opened (kernel-overlap-testing,
simple_server...)

Al traces are imported with trace type set.
The traces from folder "clashes" are
renamed with suffix (2). Make sure that the
traces can be opened

The specified traces are imported with trace
type set. Make sure that the traces can be
opened.

Correct menu opens (Open , Copy,
Trace is opened and views are populated
Trace is replicated under the new name

Trace is renamed. The trace editor is closed.

Trace is deleted. The trace editor is closed.
Trace is opened
Trace is deleted. The trace editor is closed.

Trace is opened

The first trace editor is simply brought to
front.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot
SWTBot
SWTBot
SWTBot
SWTBot
SWTBot

SWTBot

SWTBot

Numpad-enter doesn't work

ProjectView



5.1
52

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8
6.9
6.10

6.11

71
7.2

7.3

7.4

7.5

7.6

7.7

7.8

7.9

7.10

71

8.1

8.2

8.3

8.4

8.5

9.1

9.2

Experiments Folder

Experiments menu
Create experiment

Experiment

Experiment menu

Select Traces dialog

Select traces

Open experiment

Copy experiment

Rename experiment

Delete experiment

Open Experiment (Accelerator)
Delete Experiment (Accelerator)
Delete Experiment (open
experiment)

Select Traces while Experiment is
open

Experiment Traces
Trace menu

Open trace

Remove trace

Drag and Drop from Traces
Drag and Drop from other Tracing
project

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop from external (non-
traces)

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)
Drag and Drop of trace while
Experiment is open

Propagation
Preparation

Rename propagation

Delete propagation
Propagate trace type 1

Propagate trace type 2

Properties View
Synchronization

Trace synchronization

Other trace nodes synchronization

Select the Experiments folder and open it
context menu
Select the New menu and provide experiment

Select an experiment and open its context menu

Select the Select Traces menu
Select a few LTTng traces and finish
Select the Open menu

Select the Copy menu and provide a new name.

Select the Rename menu and provide a new
Select the Delete menu and confirm deletion
Select an Experiment and press Enter
Select an Experiment and press Delete and
Open an experiment, select experiment and
press Delete and confirm deletion

Open an experiment and select an additional
trace (see 6.3)

Select an LTTng trace and open its context

Select the Open menu

Open Experiment, select the Remove menu and

confirm removal

D&D a few LTTng traces from the Traces
directory

D&D a few LTTng traces from another Tracing
project's Traces folder

D&D a few traces from a non-Tracing project

D&D a few traces from an external file manager

D&D a few files (non-traces) from an external file

manager
1) D&D a trace with name of an existing trace
into experiment folder

2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same
destination folder

Open an experiment and D&D a trace from the
Traces directory (see 7.4)

Copy experiment

In Traces folder, rename a trace showing in both

experiments

In Traces folder, delete a trace showing in both
experiments

Add a trace to 2 experiments. Change its type
from Traces

Add a trace to 2 experiments. Change its type
from one of the experiments

Select a trace under a Traces folder in Project
Explorer view. Repeat with trace under an
Experiment.

Select a Traces folder, Experiments folder, or an

experiment in Project Explorer view.

Correct menu opens (New, Manage XML
Analysis, Refresh)
Experiment appears under folder, no traces

Correct menu opens (Select, Open , Copy,
Select Traces dialog is open and populated
Selected traces are imported in the
Experiment opened and views populated
Experiment is replicated under the new
Experiment is renamed

Experiment is deleted

Experiment is opened

Experiment is deleted

Experiment is closed and deleted
Experiment is closed and selected traces
are imported to the experiment

Correct menu opens w/ Copy disabled +

Trace is opened and views are populated
Experiment is closed, trace is removed from
experiment

Selected traces are added to the experiment
with proper icon. Experiment can be
opened.

Selected traces are added to the experiment
+ Traces with proper icon. Experiment can
be opened.

Selected traces are added to the experiment
+ Traces with proper icon. Experiment can
be opened.

Selected traces are added to the experiment
+ Traces with proper icon. Experiment can
be opened.

Selected traces are added to the
experiment. Traces with proper icon
(system's). Experiment cannot be opened.
Verify that trace is added into the traces
folder and experiment folder with the trace
name of the original trace plus a suffix (2)
Verify that trace is added into the traces
folder and experiemnt folder with the trace
name of the original trace plus a suffix (3)
Experiment is closed and selected traces
are imported to the experiment

Selected experiment is replicated

New name is propagated to both
experiments

Selected trace is removed from both
experiments; also propagates when deleting
trace in experiment

All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the
selected trace's "Resource properties"
Property and Value. The "Info > type"
property shows the selected trace category
and trace type name.

The Properties view is updated with the
selected item's Property and Value. For
Experiment verify the "type" property is set.

RCPTT
RCPTT

RCPTT
RCPTT
RCPTT
Manual
RCPTT
RCPTT
RCPTT
RCPTT
RCPTT
Manual

Manual

RCPTT

Manual

RCPTT

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Automation

Numpad-enter doesn't work

Automation
Candidate

Automation
Candidate

See TestimportExportPackageWizard

Automation
Candidate

Automation

It also propagates when renaming trace in experiment (not IF): Bernd. Don't understand comment Candidate

Automation

eclipse. bug.cqi?id=579305 Candidate

Automation
Candidate

Automation
Candidate

| don't see an Info prefix or so in that view; amend test text?
Info shows for experiments though. Bernd: Info is the root node in the view and not a prefix.

Kyrollos: The goal of this test is to simply open a trace and observe if the properties changes in the property view?
When experiment is selected, changing its type does not change the type property in the properties view

until the experiment is selected again. Bernd: That's the view. It when

a selection event is created and when the selected element is changed

Kyrollos: When The experiment type changes. The experiment closes and have to reopened it again and Automation
the view on the right changes Candidate

ProjectView
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https://bugs.eclipse.org/bugs/show_bug.cgi?id=579305

9.3

9.4

10

10.1
10.2
10.3

11

1.1

1.2

1.3

11.4

1.5

11.6

1.7

11.8

11.9

11.10

1.1

1.12

11.13

12

121

12.2

12.3

12.4

12.5

Check trace properties

Check trace properties -
experiment

Trace Type Selection

Preparation
Trace properties
Trace filtering

Supplementary Files

Preparation

Create Supplementary File (State
History File) from trace

Trace Context sensitive menu
Delete Supplementary Files Action

Select and delete State History
File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files Action

Select and delete State History
File

Select and delete multiple State
History files

Delete Trace

Delete Experiment

Delete Experiment Trace
Delete Supplementary Files Action
while trace is open

Link With Editor

Preparation

Select trace/experiment in Editors
area

Select opened traces/experiments
in Project Explorer

Preparation

Select trace/experiment in Editors
area

Open an LTTng kernel trace, click on the trace,
check the new properties view.

Open an experiment which contains LTTng
kernel traces, click on the experiment, then
select each trace under experiment, check the
new properties view.

Import a file with unrecognized trace type
(${local}/t limport/unr ized.log)
Select the trace and open the Properties View
Select an experiment and open "Select

1) In Project Explorer remove filter for hidden
resources (Coolbar menu > Customize View...

> unselect ".* resources)
2) Create Experiment with 2 LTTng CTF
traces in it

Open a LTTng CTF trace and wait for indexing to

finish

a) Select trace under Folder Traces and click
right mouse button

b) Redo test: Select trace under Experiment
Folder

i) Séle}:t il:ace :and clié:l; }iighrtingouse button
2) Select 'Delete Supplementary Files..."
Select <trace name>/StateHistory.ht file and
click on 'Ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse
button
2) Select 'Delete Supplementary Files..."

Select one history file (<trace
name>/StateHistory.ht) and click on 'Ok’

1) Redo 11.2 and 11.6

2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and
Supplementary File

b) delete Experiment

a) redo 11.6 to create experiment and
Supplementary File

b) remove traces under Experiment

Open trace and then redo 11.4
1) In Project Explorer make sure that "Link

with Editor" button is selected
2) Open multiple traces and experiments

Select several traces and experiments one after

each other in Editors area

Select several open traces and experiments one

after each other in Project Explorer

1) In Project Explorer make sure that "Link with
Editor" button is not selected

2) Open multiple traces and experiments (if not

Select several traces and experiments one after

each other in Editors area

"Trace properties" should be populated

The "Trace properties" should be populated
for every subtrace when it is selected

Imported trace appears in Traces with
default icon. File can be opened by default
Editor (either Eclipse text or system editor
depending on plug-ins installed)
Properties "type" and "type ID" are blank
Untyped trace does not appear in list

Verify that .tracing directory is shown under
the project

Verify that org.eclipse.tracecompass.
analysis.os.linux.kernel.ht is created under .

Verify that menu item 'Delete Supplementary
Files..."is shown in the context-sensitve
menu

Verify that confirmation dialog box is opend
and <trace name>/StateHistory.ht is listed
Make sure that file .tracing/<trace
name>/StateHistory.ht is deleted from the
Verify that two StateHistory.ht files are
created under .tracing/<trace1 name>/ and .
Iltracing/<trace2 name>/ respectively. Also
verify, that supplementatry folder for the

Verify that confirmation dialog box is opend
and shows 3 root entries:

<exp name>, <trace1 name> and <trace2
name>, with their respective supplementary

Make sure that the selected file .
tracing/<trace name>/StateHistory.ht is
deleted from the project explorer view

Make sure that both history files are deleted
under .tracing/<trace1 name>/ and .
tracing/<trace2 name>/ respectively

Verify that supplementary directory .
tracing/<trace name>/ is deleted.

Verify that supplementary File StateHistory.
ht .tracing/<trace1 name>/ and .
Jtracing/<trace2 name>/ are NOT deleted.
Also verify that the supplementary folder for
the experiment ./tracing/exp_name_exp is
Anlatad

Verify that supplementary File StateHistory.
ht .tracing/<trace1 name>/ and .
Itracing/<trace2 name>/ are NOT deleted
Verify that trace is closed and
supplementary files are deleted

Verify that after each selection the
corresponding trace or experiment element
is selected in the Project Explorer

Verify that after each selection the
corresponding trace or experiment is
brought to the top in the Editors area

Verify that selection in Project Explorer
doesn't change

Manual

Manual

SWTBot
Manual
SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

Manual

RCPTT

RCPTT

small problem, might be GTK3

ProjectView

Automation
Candidate

Automation
Candidate

Automation
Candidate
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12.6

13.1

13.2

13.3

13.4

13.7

13.8

13.9

13.10

13.11

13.12

13.13

13.14

13.15

13.16

14.1

Select opened traces/experiments Select several open traces and experiments one

in Project Explorer
Trace Package Export Wizard

Preparation

Open the trace package export
wizard

Select Traces

Deselect/Select All

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

Change export options, change
compression

Change export options, change
format

Change export options, change
format and compression

Finish the wizard

Overwrite

Verify formats

Verify content

Partial selection
Trace Package Import Wizard

Preparation

after each other in Project Explorer

1) Import 2 traces that generate
supplementay files (trace2, kernel_vm)

2) Open both traces, wait for the indexing to

finish

2) Add bookmarks in the two traces
Click on “File”, “Export...”, “Tracing”, “Trace
Package Export” and click Next

On the left side, select the project in which the
traces were imported. Then on the right side,
select both traces.

With traces selected, press the Deselect All
button. Then press the Select All button. Click
Next.

Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click

Deselect All. Then click Select All again.
1) Click on the Browse button.

2) Select a location on the filesystem

3) Enter the file name export.tar

Unselect the “Compress” checkbox.

Change to Zip format

Change to Tar format then select the Compress

checkbox.

Click Finish

Open the wizard again and select the traces
(step 13.2, 13.3). Click Finish.

Open the wizard again and select the traces
(step 13.2, 13.3). This time, choose Zip format.

Open the tar.gz and zip files in an archive
manager.

Open the wizard again and select the traces
(step 13.2, 13.3). This time, unselect both
Supplementary files subtrees. Click Finish.

Create an empty tracing project. Make sure
you have export.tar.gz available from the
Trace Package Export Wizard (13) test case,
which should include everything including
trace files, supplementary files and export-
manifest.xml.

Verify that Editor in focus is not changed

A wizard should appear with a list of projects
and traces to select. Next button should be

Next should become enabled when the first
trace is selected. If all traces are unselected,
the Next button is disabled.

Next should become disabled after Deselect
All, enabled after Select All.

All elements in the trace tree are unselected,
the Approximate uncompressed size field
changes to a lower number.

All elements in the trace tree are unselected,
the Approximate uncompressed size field
changes to 0. The Finish button is disabled.
When Select All is clicked, all the tree
elements are selected, the approximate size
increases. When Deselect All is clicked, all
the tree elements are deselected and the
approximate size decreases.

Afile chooser dialog comes up. When the
destination file is entered, the “To archive
file” is filed with export.tar.gz. The Finish
button should be enabled.

The name of the archive file changes to
export.tar

The name of the archive file changes to
export.zip

The name of the archive file changes to
export.tar.gz

A progress bar should appear at the bottom
the the dialog and it should disappear upon
completion. The export.tar.gz file should be

The Archive file name should be
remembered and already filled. A dialog
should prompt the user to overwrite.
Answering No should keep the wizard
opened. Answering Yes should re-export the
archive and close the wizard.

The export.zip file should be created on the
file system

In both archives, verify that it contains:

1) A trace folder for each trace containing all
the trace files (excluding supplementary
files)

2) A .tracing folder containing all the
supplementary files

3) An export-manifest.xml file listing the
trace files, supplementary files and
bookmarks

Verify that both exported archives contain:
1) A Traces folder containing all the trace
files (excluding supplementary files)

2) No .tracing folder

3) An export-manifest.xml file listing the
trace files and bookmarks

ProjectView

RCPTT -

Manual Kyrollos: Could not find traces that can generate trace2 and kernel_vm supplementary files
SWTBot May be the description needs to be updated because Export option is not under file. | can find the export option when | right click the traces folder
SWTBot
SWTBot
SWTBot
Automation
Manual Candidate
Automation
Manual Candidate
Automation
Manual Candidate
SWTBot
SWTBot
Automation
Manual Candidate
SWTBot
Automation
Manual Candidate
Automation
Manual Candidate
Manual
Manual
Manual

12



14.2

14.3

14.4

14.5
14.6

14.7

14.8

14.9

14.10
14.11

14.12

14.13
15

15.1

15.2

15.3

15.4

15.5

15.6

15.7

15.8

Open the trace package import
wizard

Project Selection

Archive file selection

Deselect/Select All
Trace element selection

Trace sub-element selection

Select/Deselect All

Finish the wizard

Supplementary Files

Bookmarks

Open from bookmark

Overwrite
Time Offsetting

Preparation

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog -
experiment selection

Apply time offset dialog - Basic
mode

Apply time offset dialog -
cumulative offset

Clear time offset

Apply time offset dialog -
Advanced mode

Click on “File”, “Import...”, “Tracing”, “Trace
Package Import” and click Next

Click the Select button. Choose the previously
created project.

1) Click on the Browse button.

2) Browse for export.tar.gz on the file system
With traces selected, press the Deselect All
button. Then press on the Select All button.
Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click
Deselect All. Then click Select All again.

Click Finish

Right-click on trace2 in Project Explorer

Open the Bookmarks view

Double click on one of the bookmarks

Open the wizard again (step 13.2) and select the
archive file (step 13.4). Click Finish.

Open Project Explorer view and Properties
view. Create an empty tracing project. Import
two different traces to the project. Open the
traces and note their start time. Close the
traces.

Select both trace elements in the Project
Explorer view. Right-click and select Apply Time
Offset...

Select the Traces folder element in the Project
Explorer view. Right-click and select Apply Time
Offset...

Create an experiment with both traces. Select
the experiment element in the Project Explorer
view. Right-click and select Apply Time Offset...
Select a trace element in the Project Explorer
view. Right-click and select Apply Time Offset...
In the Offset in seconds column, enter a time
with seconds and decimals. Click OK. Open the

Select the same trace element in the Project
Explorer view. Right-click and select Apply Time
Offset... In the Offset in seconds column, enter a
time with seconds and decimals. Click OK. Open

Select the trace element in the Project Explorer
view. Right-click and select Clear time offset.
Click OK to confirm. Open the trace.

Open one trace and close the other trace. Select
both trace elements in the Project Explorer view.
Right-click and select Apply Time Offset...
Choose the Advanced radio button.

The first page of the wizard should appear
(Choose content to import)

The Into project field gets filled with the
selected project name.

Finish should be become enabled when the
first trace is selected. If all traces are
unselected, the Next button is disabled.
Finish should become disabled after
Deselect All, enabled after Select All.

All elements in the trace tree are unselected.

All elements in the trace tree are unselected.
When Select All is clicked, all the tree
elements are selected. When Deselect All is
clicked, all the tree elements are

A progress bar should appear at the bottom
the the dialog and it should disappear upon
completion. The two traces should appear
under the project in Project Explorer
Delete Supplementary files appears in the
content menu

Bookmarks view appears

The corresponding trace opens at the
bookmarked event. Bookmarks are
displayed in the event table.

A dialog should prompt the user to overwrite
for each trace. Answering Yes to All should
overwrite without prompting again.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces
and the Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces
and the Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces
and the Offset in seconds is blank.

The timestamps in the trace are all offset by
the entered value. The Properties view
shows the ‘'time offset' with the entered
value.

The timestamps in the trace are all offset by
the cumulative sum of the previous and
current entered value. The Properties view
shows the 'time offset' with the cumulative

The timestamps in the trace are back to their
original values. The Properties view shows
the 'time offset' as blank.

The Apply time offset dialog opens and is
switched to Advanced mode. The Trace
name shows both traces and the Offset in
seconds is blank. The Reference time for
the opened trace is set to its start time.

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

Manual

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Sometimes the selected event is the one just above the bookmark.
Goes away if double-clicking again. Unrelated to the imported bookmark though;
noticed also for the original bookmark. Bernd: | can't reproduce

https://bugs.eclipse.

bug.cqi?id=579323

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

ProjectView
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https://bugs.eclipse.org/bugs/show_bug.cgi?id=579323

15.9

15.10

15.11

Apply time offset dialog -
Advanced mode - compute from
selection

Apply time offset dialog -
Advanced mode - compute from
entered values

Clear time offset with opened
traces

Double-click the second trace to open it. Select
an event in its trace editor. Select the first trace
editor. Select an event in its trace editor. Click
the button in the dialog row of the second trace.
Click OK. Open both traces.

Select the first trace element in the Project
Explorer view. Right-click and select Apply Time
Offset... Choose the Advanced radio button.
Double-click the trace name to open it. Select
the Reference time cell and copy the start time.
Select the Target time and paste the value. Edit
both values to different times. Click the button in
the trace row. Click OK. Open the trace.

Open both traces. Select both trace elements in
the Project Explorer view. Right-click and select
Clear time offset. Click OK to confirm. Open the
traces.

Both traces are open. Selecting an event
updates the Reference time for the selected
trace, and updates the Target time for all
traces. Pressing the button computes the
Offset in seconds as the difference between
Target time and Reference time for that row.
The trace which has a computed offset is
closed when the OK button is pressed. After
reopening, the two previously selected
events now have the same timestamp. The
Properties view (selected trace in Explorer)
shows the 'time offset' with the computed
value.

The trace is opened. The Reference time is
set to the trace start time. The Reference
time and Target time can be copied, pasted,
and edited. Pressing the button computes
the Offset based on the current time values.
The trace is closed with the OK button is
pressed. After reopening, the timestamps in
the trace are offset according to the
computed value. The Properties view shows
the 'time offset' with the computed value.
The opened traces are closed when the OK
button is pressed. After reopening, the
timestamps in the traces are back to their
original values. The Properties view shows
the 'time offset' as blank.

Manual Kyrollos: The description isnot clear
Manual
Manual No time offset field in properties

Automation
Candidate

ProjectView
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BookmarksView

Section Automated To Do Comments
TMF - Bookmarks View

Target:

Test Case Verification Comment

1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with  SWTBot Pass

2 Trace bookmarks

2.1  Show Bookmarks View Select Bookmarks view (bottom folder) Bookmaks view is shown SWTBot Pass
Views are populated. Verify that a
2.2 Open trace Open an LTTng CTF Kernel trace Kernel events editor is opened SWTBot | Pass

Make sure that bookmark icon is
shown on left site of the event row
and is added to the Bookmarks view
with relevant information (i.e.
Description entered and correct trace

ranALirAan)

Add a bookmark, by

a) double-clicking on the left margin next to an event
b) right-clicking the margin and select Add bookmark....
¢) using the Edit > Add bookmark... menu.

2.3  Add Trace Bookmark Enter the bookmark description in dialog box SWTBot Pass

Scroll within event table so that bookmark is not visible anymore Make sure that event with bookmark

2.4  Open Trace Bookmark (1) and then double-click on bookmark in Bookmarks View is selected and visible in event table SWTBot Pass
Open another trace #2 and then double-click on bookmark in ~ Make sure that correct trace #1 is
2.5 Open Trace Bookmark (2) Bookmarks view brought to top and correct event with  SWTBot | Pass
Close the trace #1 and then double-click on bookmark in Make sure that correct trace #1 is
2.6 Open Trace Bookmark (3) Bookmarks view opened and correct event with SWTBot | Pass
Make sure that bookmark icon is
Delete Bookmark (from  Select bookmarks icon in event table right-click on icon and removed from event table and
2.7 table) select "Remove Bookmark" corresponding bookmark is removed  swTBot | Pass
Make sure that bookmark icon is
Delete Bookmark (from removed from event table and
2.8 table) Double-clicking bookmarks icon in event table. corresponding bookmark is removed  swTBot | Pass
Add a bookmark (see 2.4), then select bookmark in Bookmarks Make sure that bookmark icon is
Delete Bookmark (from  view, right mouse click and select "Delete". Confirm the removed from event table and
2.9  Bookmarks view) deletion. corresponding Bookmark is removed  gwTBot | Pass

3 Experiment bookmarks

Create and open Create Experiment with 2 LTTng CTF Kernel traces in it and Verify that an Events editor is
3.1 experiment open experiment opened showing LTTng Kernel SWTBot | Pass

15



3.2

3.3

3.4

3.5

3.6

3.7

Add a bookmark, by
a) double-clicking on the left margin next to an event
b) right-clicking the margin and select Add bookmark....
Add Experiment c) using the Edit > Add bookmark... menu.
Bookmark Enter the bookmark description in dialog box

Open Experiment Scroll within event table so that bookmark is not visible anymore
Bookmark (1) and then double-click on bookmark in Bookmarks View

Open Experiment Open another trace #2 and then double-click on bookmark in
Bookmark (2) Bookmarks view

Open Experiment Close the experiment #1 and then double-click on bookmark in
Bookmark (3) Bookmarks view

Delete Bookmark (from Select bookmarks icon in Events view, right-click on icon and
table) select "Remove Bookmark"

Add a bookmark (see 6.4), then select bookmark in Bookmarks
Delete Bookmark (from view, right mouse click and select "Delete". Confirm the

Bookmarks view) deletion.

Make sure that bookmark icon is
shown on left site of the event row
and is added to the Bookmarks view
with relevant information (i.e.
Description entered and correct

H \

AvnArvibraAant racALIrAA

Make sure that event with bookmark
is selected and visible in event table
Make sure that correct experiment #1
is brought to top and correct event
with bookmark is selected in events

Make sure that correct experiment #1
is opened and correct event with

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed

Make sure that bookmark icon is
removed from event table and
corresponding Bookmark is removed

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

BookmarksView
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Section
LTTng 2.0 - I/O Analysis

Target: Windows

Step Test Case

0

0.1

—

1.5

Prerequisites

Import traces
Project View

Check analysis can execute

Verify help message when applicable

Check analysis for another trace type
View Management

Populate analysis's view

Open view

Pass

Action

Import LTTng
Kernel traces in
Tracing project

In the project
explorer,
expand a LTTng
Kernel trace

In the project
explorer, open
and expand the
LTTng kernel
trace, right-click
the Input/Output
analysis and
select Help

In the project
explorer,
expand a non-
LTTng Kernel
trace

Open an LTTng
kernel trace and
expand the
"Input/Output”
analysis in the
project explorer

Double-click the
Disk 1/0 Activity
View under the
Input/Output
analysis

Fail

Verification

"Input/Output”
analysis is
present and
"normal" (not
striked-out)

A generic help
message
appears with
the name of the
analysis

"Input/Output”
analysis is not
present

"Disk I/O
Activity" View
appears under
the analysis
The Disk I/0
Activity view
opens and
triggers the
input/output
analysis. After
the analysis, the
Xy charts is
populated.

Automated To Do Comments

6 0
Type
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass

7

Comment

LTTng 2.0-10
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2.3 Close trace
2.4  Open trace
2.5 Close view
2.6 Re-open view
| 3 |View selection
4 Mouse handling
4.1 Drag move time range
4.2  Zoom time range (mouse wheel)

Close the trace
With the view
already opened,
open the trace
Close the Disk
1/0 Activity view
Double-click the
Disk 1/0O Activity
view under the
Input/Output
analysis in
project explorer.

Drag move xy
chart left and
right with middle
button

Zoom with
mouse wheel up
and down,
cursor inside xy
chart

The Disk I/O
Activity view is
emptied.

The Disk I/O
Activity view is
populated.
The view is
closed.

The view opens
and is
automatically
populated.

Time range is
dragged. When
mouse button is
released, series
are updated and
new time range
is propagated to
other views.
Time range is
zoomed in and
out, relative to
mouse Cursor.
When mouse
wheel is
stopped for a
short time,
series are
updated and
new time range
is propagated to
other views.

Manual

Manual

Manual

Manual

Manual

SWTBot

Graph is emptied.

Disks are unchecked when opening the trace. Bernd: That's the expected
behaviour

Disks are unchecked: Bernd: That's the expected bahviour

Small lag detected. Bernd: Can't reproduce

LTTng 2.0-10
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4.3

4.4

4.5

4.6

Drag zoom time range

Mouse hover

Drag mouse selection

Shift key selection

Drag select time
graph with right
button in xy
chart

Hover mouse in
xy chart region
anywhere

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, series
are updated and
new time range
is propagated to
other views.
Tool tip shows
the puntual disk
activity, with
units in <unit>/s
Selection
highlighted and
selection range
is propagated to
other views

Selection
highlighted and
selection range
is propagated to
other views

Manual

Manual

Manual

Manual

LTTng 2.0-10
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4.70 Drag mouse selection (Status bar)

4.8

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative)
Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative

Manual

LTTng 2.0-10
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6.1

6.2

6.3

6.4

Time synchronization

Time range synchronization

Time range selection synchronisation

Disk I/0 Activity works with experiments

Select a random
time in another
view

Select a new
time range in
Disk 1/0 Activity
view or in
Histogram view.

In any other
view that
supports range
synchronization,
select a new
range.

Selected time
line is updated.
If selected time
is outside
current range,
time range is
updated to

include it. Manual

Time range is
updated.
Selection is
highlighted. If
the most left
time (T1) of
selected time
range is outside
the current
range, then time
range is
updated to
include it

Manual

Manual

See bug in
comment for
acceptance

criteria. Manual

Updated with a small lag. Kyrollos: There is no lag

it doesn't include T1. Bug or update? Bernd: | think the time range is
moved when T1 is outside the current window, only if one timegraph view
is open. That behaviour is not triggered when only xy-charts is open.
Instead it should be centrally triggered in dependent on the views that are
open.

Kyrollos: T1 is always visible in the I/O Activity even if the less minimal
value chosen is outside the current view.

agree with this. | will say bug is fixed check image in the link for

verification: https://drive.google.com/file/d/1Bglzdyya6293qZxC7MtQIP-
M9fdOvjzx/view?usp=sharing

LTTng 2.0-10

Doesn't really work well you see both trace in the tree, but when you check Fixed Bug 558203
element it is not the right color and both trace show the same data .(IF) not https:/bugs.

org/bugs/show_bu
.CQi?id=558203
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FiltersView

Section Fail Automated To Do Comments
TMF - Filters View 12 12 0 |1
Target:
Step Test Case Action Verification Type Comment

Open a trace to be

1 filtered Trace is opened SWTBot SWTBot Pass

2 Open filter view Filter view is opened SWTBot SWTBot Pass
Create a filter on event The filterview contains a filter on the event type and the

3 type and timestamp timestamp SWTBot SWTBot Pass

3.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass

Create a filter on the
timestamp oring field

4 values Create the filter SWTBot SWTBot Pass

4.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with

5 equals node Create the filter SWTBot SWTBot Pass

5.1  Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with

6 matches node Create the filter SWTBot SWTBot Pass

6.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with

7 contains node Create the filter SWTBot SWTBot Pass

7.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
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StatisticsView

Section Automated To Do Comments
TMF - Statistics View

Target: Windows

Step Test Case Action Verification Type Comment

1 Preparation
Download traces simple-server-thread1 and simple-server-

Preparation thread1 from traces/import/
1.1 Open Perspective Open and reset LTTng Kernel perspective LTTng Kernel perspective SWTBot Pass
When running the Trace Compass RCP:
Use menu Window — Show View — Tracing — Statistics Path is actually Window -> Show view -> Tracing ->
Statistics:
i i i i . . . e . Bernd: The description on the right is when TC is installed in
\S/hen runn\l/rc/g -grace Cg?pas\/s. mSta”%dﬂ:n ECIIpse_I._ . Verify that 'Statistics' view is an Eclipse IDE. Running the RCP the menu is as you
1.2 Open TMF Statistics View YS€ menu Window — show View — Other ... — lracing — shown SWTBot | Pass | descriped.
1) Create Tracing Project Verify that statistics are shown
2) Create Experiment (SeqExp) per trace and per event type.
3) Import 2 traces simple-server-thread1 and simple-server- Each trace has 80021 events.
thread2 Verify that event types
4) Select trace type "Generic CTF Trace" ENTER/RETURN/SEND/RECE
5) Add these 2 traces to experiment IVE/INFO/after_fork_child are
1.3  Open experiment counted. RCPTT Pass
2 Manage View
21 Delete view Close the 'Statistics' View Statistics' view is removed from  RCPTT Pass
Statistics' view View is
2.2  Open view Use menu Window — Show View — Tracing — Statistics displayed and re-populated RCPTT Pass
Open view when Verify that statistics are shown
experiment/trace is 1) Close 'Statistics View' 2) load trace above trace 3) Open per trace and per event type.
2.3  already loaded 'Statistics' view Each trace has 80021 events. RCPTT Pass
3 Other
. , e X not populated gradually (nt sure about indexation)
Verify that 'Statistics' view is Bernd: When opening a trace the 1st time, the stats are
populated gradually during updated gradually. Every subsequent opening, the data is
3.1 Build of statistic index Open trace indexation Manual Pass | fetched from the statistic state system and will happen in one
Verify that when opening the
Open same trace multiple times after indexing of trace was trace the x-times (x > 1), that
3.2  Persistence of statistics  finished the first time the statistics appear right away  pjanyal Pass

4 Range Synchronization

External synchronization  In any other view that supports range synchronization, select ~ Events in 'Events in selection’ Automation
4.1 (full) the full range of the trace. is updated and equals 'Events Manual Pass Candidate

External synchronization  In any other view that supports range synchronization, selecta  Events in 'Events in selection’ Automation
42  (range) new range. is updated according to new Manual Pass Candidate

Multiple Trace
5 Synchronization
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5.1

5.2

5.3

5.4

5.5

5.7

5.8

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Select other trace (no
overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace
(overlap)

Close all traces

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-overlap-
testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

In any other view that supports range synchronization, select a
new range

Select different trace by clicking its Events editor tab
- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-click -> "Follow

In any other view that supports range synchronization, select a
new range

Select different trace by clicking its Events editor tab

Close all Events editor tabs

View shows the last opened
trace

Events in 'Events in selection’
is updated according to new
View is updated to show
selected trace. 'Events in
selection’ is updated according
View shows the last opened
trace

Events in selection' is updated
according to new range

View is updated to show
selected trace. 'Events in

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

StatisticsView

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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TimeChartView

Section Pass Fail Automated ToDo Comments
TMF - Time Chart View 26 1 0 9
Target: Windows

Step Test Case Action Verification Type Comment

1 Preparation

LTTng Kernel perspective opens
1.1 Preparation step 1 Open and reset LTTng Kernel perspective with correct views. SWTBot Pass | Candidate for incubator
Automation
1.2 Preparation step 2 Show Time Chart View Time Chart view is shown Manual Pass Candidate
2 Trace handling
X Not sure about entry being selected or not in chart; seems not
T,race #1 entry _added to _T'me Chart Bernd: The trace is in not selected in the view. However, the opened trace
view. Trace #1 is the active trace. is the current active trace, i.e. the other views are updated with that trace. Automation
21 Open trace Open an LTTng CTF Kernel trace #1 Range of view is full trace range. Manual Pass |1l change the description. Candidate
Trace #2 entry added to Time Chart
view. Trace #2 is the active trace.
Range of view is union of full trace Hard to convert from chart's dates to other views timestamp Automation
2.2 Open other trace Open an LTTng CTF Kernel trace #2 ranges. Manual Pass  |Bernd: Ack not obvious about the union of full trace ranges. Candidate
Experiment entry added to Time
Chart view. Experiment is selected
entry. Range of view is union of full Automation
2.3  Open experiment Open an experiment trace ranges. Manual Pass Candidate
Trace #1 is selected entry. View
range does not change. Trace #1 Automation
2.4  Select other trace Select trace #1 by clicking its trace entry in Time Chart view editor tab is brought to top. Manual Pass Candidate
Trace #2 is selected entry. View The tint given to the selected trace is not very visible. Hoang: More like ~ Automation
2.5  Select other trace (external) Select trace #2 by clicking its editor tab range does not change. Manual Pass | the highlight tint is gone. Candidate
Time Chart view is removed from Automation
2.6 Close view Close the Time Chart view tracing view Manual Pass Candidate
Time Chart view is displayed and re- Automation
2.7  Open view Show Time Chart view populated with opened traces data Manual Pass Candidate
Trace e,ntry s remO\{ed from T'me Once back to only one trace in chart, it shows timestamps (no dates)
Chart view. Range viewed is union Bernd: The time axis scale is updated according the full range. If you open Automation
2.8  Close trace/experiment Close trace #2 editor tab. Repeat with experiment editor tab. of remaining full trace ranges. Manual Pass  |a trace from different days, the format is days. Candidate
Automation
2.9 Close last trace Close trace #1 editor tab View is cleared. Manual Pass Candidate
3 Time Synchronization
Other views are synchronized to the
selected time. Event at or following
the selected time is selected in the
3.1 Mouse synchronization (single time)  Left-click on the time chart. The selected time line is updated. event table. Manual Pass
Other views are synchronized to the
selected range. Event at or following
Shift-left-click or left-drag on the time chart. The selected time  the selected time is selected in the
3.2 Mouse synchronization (time range)  range is updated. event table. Manual Pass
Selecte_d time line is updated to_the I don't understand the "If necessary” part.
event time. If necessary, range is Bernd: if necessary means, that if the selection is not in the current
3.3  External synchronization (single time) In event table, select an event. updated to show selected time. Manual Pass | window range, then then window range is moved
If T2 is outside of current range, view will be updated to include it (and not
necessarily T1).
(IF) it could be confusing if we have multiple trace in time chart
. L Kyrollos: If the time range is bigger than the zoom level T1 and T2 are not
Selected time line is updated to the included in the window and we have to horizontally scroll to see all the
3.4  External synchronization (time range) In event table, select an event range with shift-left-click. time range. Manual Pass  |selected range

4 Zoom Range Synchronization
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4.1

4.2

4.3

44

4.5

5.1

5.3

54

5.5
5.6

Mouse wheel synchronization
Mouse drag zoom synchronization
Mouse drag move synchronization
Mouse full range synchronization

External synchronization

Event Table Synchronization

Search synchronization
Search cleared

Filter synchronization
Filter cleared

Bookmark synchronization
Bookmark cleared

Zoom infout with mouse wheel while holding Ctrl.
Drag zoom with 1. right-button, 2. drag to select new zoom
range -on time chart.

Drag move with ctrl-left or middle button on time chart.
Double-click with left button on time chart's time scale.

In any other view that supports range synchronization, select a
new zoom range.

Enter a search regex in event table
Clear the search regex in event table

Enter a filter regex in event table
Clear the filter regex in event table

Add a bookmark in event table
Remove the bookmark in event table

Other views are synchronized to the
new range

Other views are synchronized to the
new range

Other views are synchronized to the
new range

Other views are synchronized to the
full range

View range is updated to the new
range

Matching events are marked in time
chart

Marks are removed in time chart
Non-matching events are removed
from time chart

All events are shown in time chart
Bookmarked event is marked in time
chart

Mark is removed in time chart

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual
Manual

Manual
Manual

It wasn't clear for how to do a filter
https://bugs.eclipse.org/bugs/show_bug.cqi?id=579358

TimeChartView

26


https://bugs.eclipse.org/bugs/show_bug.cgi?id=579358

LTTng 2.0 - CPU

Section Automated To Do Comments

LTTng 2.0 - CPU Analysis
Target: Windows

Step Test Case Action Verification Type Comment

0 Prerequisites
Import LTTng Kernel traces in

0.1  Import traces Tracing project

1 Project View
In the project explorer and expand a "CPU usage" analysis is present

1.1 Check analysis can execute LTTng Kernel trace and it's not crossed out SWTBot Pass  |84702
In the project explorer, open and
expand the LTTng kernel trace, right-

click the CPU usage analysis and A generic help message appears
1.2 Verify help message when applicable select Help with the name of the analysis SWTBot Pass
In the project explorer, expand a non- "CPU usage" analysis is not
1.5  Check analysis for another trace type LTTng Kernel trace present SWTBot Pass  |84702

2 View Management
Open an LTTng kernel trace and
expand the "CPU usage" analysis in "CPU Usage" View appears under
2.1 Populate analysis's view the project explorer the analysis Manual Pass
The CPU usage Usage view opens
and triggers the cpu analysis. After

Double-click the CPU usage View the analysis, both tree viewer and
2.2  Open view under the CPU usage analysis xy charts are populated. SWTBot Pass
2.3 Close trace Close the trace The CPU Usage view is emptied. Manual Pass
With the view already opened, open
2.4  Open trace the trace The CPU Usage view is populated. ~SWTBot Pass
2.5 Close view Close the CPU Usage view The view is closed. SWTBot Pass
Double-click the CPU Usage view
under the CPU usage analysis in The view opens and is
2.6  Re-open view project explorer. automatically populated. SWTBot Pass

3 View selection
A new series is added to the xy
Select an entry in the tree viewer chart, corresponding to the
3.1 Select an entry section selected TID SWTBot Pass

Christophe: not sure | understand. Multiple series can

A new series is added to the xy be selected; when selecting a 2nd series, the first one is

! still displayed.
Select another entry from the tree chart, and the previous TID's Simon:pl tr):ink this is old and refers to an older view.
3.2  Select another entry viewer series is not displayed anymore SWTBot Pass | with the new tree view the behavior is as you described

4 Mouse handling
Time range is dragged. When

Drag move xy chart left and right with Mouse button is released, series
4.1  Drag move time range middle button and shift mouse whee| are updated and new time range is  gWTBot Pass
Time range is zoomed in and out,
relative to mouse cursor. When
mouse wheel is stopped for a short
time, series are updated and new
time range is propagated to other

viauie inaliidina tha tran vicueAar

Zoom with ctrl mouse wheel up and

4.2  Zoom time range (mouse wheel) down, cursor inside xy chart SWTBot Pass
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Scroll with mouse wheel up and

Table scroll up and down. Selected
process does not change. Vertical

4.3  Mouse vertical scroll down, cursor outside xy chart scroll bar updated. Manual
Tree viewer scrolls up and down.
4.4  \ertical scroll bar Click and drag vertical scroll bar Selected process does not change.  Manual
Selection highlighted. When
mouse button is released, time Christophe: selected process is lost if the new time
i H range does not contain data from the process, even
Drag select time graph with right range Is Zoorge? ? Secliectlont,. whgn zooming back out. Not sure if it zhould be marked
4.5 Drag select time range button in xy chart Series aré updated and new time gy TRt as a fail.
Hover mouse in xy chart region Tool tip shows the total and
4.6  Mouse hover anywhere selected process (if any) cpu Manual
Selection highlighted and selection
4.7  Drag mouse selection Drag select xy chart with left button  range is propagated to other views =~ SWTBot
Click select with left button (begin
time), press shift key and click select Selection highlighted and selection
4.8  Shift key selection another time (end time) range is propagated to other views  Manual
Entries are sqrted in ascending Simon: Sometime with GTK3 sorting by column cause
. then descending order on the the process column to add extra pagdirlg between the
Click on column headers once then  column value. Selected process checkbox and the label. On GTK2 everything seems
4.9  Sort columns twice does not change. Manual fine
Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
T2 the second (draggged) selected
time and delta the time difference
4.10 Drag mouse selection (Status bar) Drag select xy chart with left button  between T2-T1 (can be negative) Manual
Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
Click select with left button (begin T2 the second (draggged) selected
time), press shift key and click select time and delta the time difference
4.11  Shift key selection (Status bar) another time (end time) between T2-T1 (can be negative) Manual
5 Keyboard handling

LTTng 2.0 - CPU
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5.1

6.1

6.2

6.3

6.4

Keyboard navigation in tree viewer
Synchronization

Time synchronization

Time range synchronization

Time range selection synchronisation

CPU usage works with experiments

With focus on table, use UP, DOWN,
HOME, END keys

Select a random time in another view
Select a new time range in CPU
usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Selected process in table is
changed. Vertical scroll bar
updated.

Selected time line is updated. If
selected time is outside current
range, time range is updated to
include it.

Time range is updated.

Selection is highlighted. If the most
left time (T1) of selected time
range is outside the current range,
then time range is updated to
include it

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - CPU

No xy chart selection. Test needs to be updated?
Bernd: Verification text doesn't make sense. I'll update

Time range is updated

it doesn't update when T1 is outside of current range
Bernd: It works when a timegraph view is open.
Kyrollos: when an experiment is open with two traces
that support CPU analyses only one of the traces can
be expended in the table and the other one does not
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Target:

1.1

1.2
1.3

21
22

3.1

4.1

5.1

Section
Counters View
Windows

Test Case

Preparation
LTTng trace with counters

LTTng trace with no counters
Non-LTTng (no counters)
Displaying counters data

Open Counters view (after 1.1)
Populate xy-chart
Filtered checkbox tree

Re-do 2.1 + filter
Supporting experiments

Experiment with LTTng trace with
counters

Persistence between traces

Action

Import an LTTng trace with counters

(e.g. kernelVM in test traces) and open trace
Import LTTng trace with no counters, e.g (glxgears-cyg-
profile in test traces) and open trace

Import non-LTTng trace and open trace

Double-click the Counters View under the Counters
analysis

Select several checkboxes in tree viewer

Type string in filter text box (e.g. minor)

Create experiment and add an LTTng trace with
counters

(e.g. kernelVM in test traces) to it. Open experiment
and Counters view.

Verification

In the project explorer, ensure the Counters analysis and
Counters view is available (non-strikethrough)

In the project explorer, ensure the Counters analysis is strikethrough
In the project explorer, ensure there is no Counters analysis

The Counters view opens and triggers the Counters analysis.
After the analysis, both tree viewer are populated.

xy-chart populated.

Tree viewer is updated to show only entries matching the filter
string

All counters are displayed

Automated To Do

Manual

Manual
Manual

Manual
Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

N/A

CountersView

Comments

Comment

Hoang: For 8.1 tests, | used FTrace.

Hoang: | couldn't figure out why the
test says "both" trace viewers.

Hoang: Test pass but: If we have
minor and major counter selected,
and we filter out only minor, the major
line in the graph is still visible. Is this
the expected behaviour?
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CriticalPath

Automated To Do Comments
12

Critical Path
Target: Windows

Step Test Case Action Verification Type Comment

0 Prerequisites

Import the 3
django traces from

0.1 Import traces the test traces
Create an
experiment with

0.2 Create experiment the 3 traces in it
Synchronize the
experiment, it
should be
accurate and 2 of
the traces will be

0.3  Synchronize experiment  udpated

1 View management

Expand the Views element under the trace. C”t(ijca: Flow Vigw iggght
O_pen any of the The OS Exgcution Graph gnalys_is is there (é";ecjtmeéfgpﬁ’rmanua”y
django traces in and the Critical Flow view is available under on macOS.
1.1 Open trace Project Explorer  it. SWTBot Pass |Bernd: updated test case

Expand the Views element under the trace.
The OS Execution Graph analysis is there
Open the django  and "normal". The Critical Path analysis is
experiment in there and the Critical Flow view is available
1.2 Open experiment Project Explorer  under it. SWTBot Pass
Expand the Views
element, then the

Critical Path

analysis and click

on the Critical Critical Flow View, rather?
1.3  Open view Flow View Critical Flow view is opened and empty SWTBot Pass | Bernd: updated
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1.4

1.5

1.6

2.1

22

2.3

24

Close view

Unapplicable trace

‘Unapplicable experiment

View population

Populate the view with
trace

Select worker in time
graph

Select state in time graph

Select worker in tree
viewer

Close the Critical
Flow View

Open a trace that
is notan LTTng
kernel trace
Open an
experiment that
does not contain
LTTng kernel

‘traces

With the django-
client trace and
the critical path
view opened, in
the control flow
view, find the
process named
python (TID 9496).
Right-click on the
process and select
"Follow
python/9496"
Select an empty
region in the time
graph section

Select a state in
the time graph
Select a worker
from the tree
viewer section

Critical Flow view is closed

Expand the Views element under the trace.
The OS Execution Graph analysis is not
there.

Expand the Views element under the trace.
The OS Execution Graph analysis is there,

‘but striked out.

The LTTng kernel exec graph is executed
and at the end, the critical path view shows
the interaction between 3 workers.

Same process is highlighted in table.
Selected time line is updated. Other views
are synchronized to selected time.

Same process is highlighted in table. State
is highlighted in time graph. Selected time
line is updated. Other views are
synchronized to selected time.

Same process is highlighted in time graph.

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Trivial, remove or amend?
Bernd: | agree that we
have reduntant tests for
different views. They are
integrated using Trace
Compass APIs and all
should behave the same.
Maybe when updating the
test spec. we can
consolidate.

Copy-paste issue in test?
Bernd: Behavior changed. |
updated the description
and marked it as passed

Copy-paste issue in test?
Bernd: Description updated
and marked as passed

Automation
Candidate

Automation
Candidate

Automation

Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

CriticalPath
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25

255

26

2.7

2.8

3.1

3.2

3.3

Populate the view with
empty path

Select again

Re-opening

Populate the view with
experiment

Populate with trace with

‘time selection

Mouse handling

Drag move time range

Zoom time range (mouse

wheel)

Zoom time range (mouse
drag)

Repeat steps of
2.1, with django-
client trace and
process Ittng-
sessiond (TID
9355)

Repeat steps of
2.1, and select
python/9496 again
Close the django-
client trace,
reopen it and
repeat steps of 2.1
Repeat steps of
2.1, but with the
django-experiment
instead

Re-open django-
client trace. In the
Control Flow View,
select a time after
the python
process exited,
then follow the
python/9496

process

Ctrl-Drag move
time graph left and
right with middle
button

Zoom with mouse
wheel up and
down, cursor
inside time graph
while holding the
Ctl button

Drag in time graph
scale left and right
with left button

The Critical Path View is emptied

The critical path should be the same as 2.1

The Critical Path View should be populated
like in step 2.1

The LTTng kernel exec graph is executed

and at the end, the critical path view is
populated with elements from the 3 traces.

The Critical Flow View should be populated

like in step 2.1

Time range is dragged. When mouse button
is released, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is
stopped for a short time, states are updated
and new time range is propagated to other
views.

Time range is zoomed in and out. When
mouse button is released, states are
updated and new time range is propagated
to other views.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation

Candidate

Automation
Candidate

CriticalPath
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3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

4.1

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time
range

Mouse hover (empty

region)

Mouse hover (state)

Drag mouse selection

‘Shift key selection

Keyboard handling

Keyboard navigation in
table (process selection)

Scroll with mouse
wheel up and
down, cursor

outside time graph

Click and drag
vertical scroll bar

Drag select time
graph with right
button
Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Drag select time
graph with left
button

Click select with
left button (begin
time), press shift
key and click
select another

‘time (end time)

With focus on
table, use UP,
DOWN, HOME,
END keys

Table and time graph scroll up and down
and remain aligned. Selected worker does
not change. Vertical scroll bar updated.
Table and time graph scroll up and down
and remain aligned. Selected process does
not change.

Selection highlighted. When mouse button
is released, time range is zoomed to
selection, states are updated and new time
range is propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Tool tip shows process name and PID.

Tool tip shows worker name, state name,
priority, date, start time, end time, duration.
Selection highlighted. Status bar of Eclipse
is updated with time information: T, T1, T2
and delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta
the time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse
is updated with time information: T, T1, T2
and delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta
the time difference between T2-T1 (can be

‘negative)

Selected process is changed. Time graph
selection is updated. Vertical scroll bar
updated.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

[processName, pid] (e.g.
[postgres,32554])

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation

Candidate

CriticalPath
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4.2

4.3

4.4

5.1

5.2

5.3

5.4

5.5

Keyboard navigation in
table (tree expansion)

Keyboard navigation in
time graph (process
selection)

Keyboard navigation in
time graph (state

‘selection)

Tool bar handling

Align views

Show Legend

Reset Time Scale

Select Previous/Next
Event

Select Previous/Next
Element

With focus on
table,

in Windows use
LEFT, RIGHT
keys while trace or
worker is selected

in Linux use
SHIFT LEFT,
RIGHT keys while
trace or worker is
selected

With focus on time
graph, use UP,
DOWN, HOME,
END keys

With focus on time
graph, use LEFT,

RIGHT keys

Click on the Align
View Button, with
another time graph
view, eg the
Control Flow view
opened above or
under

Click Show
Legend button

Click Reset Time
Scale button
Click
Previous/Next
Event button
Click
Previous/Next
Element button

For trace, tree is expanded or collapsed.
Time graph item expansion is updated.
Vertical scroll bar updated. For workers, it
does nothing.

Selected worker is changed. Table
selection is updated. Vertical scroll bar
updated.

Previous or next state is selected. Selected

‘time is updated in other views.

When it is pressed, moving the line
between tree viewer and time graph will
move the line of the other view. If not
pressed, the line can be moved without
affecting the other views

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected worker is changed in table and
time graph. Vertical scroll bar updated.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Does the same effect as
with focus on time graph
(see 4.4) However, "Enter"
works. Update the action
description?. (IF) not sure

Align option is now in down
arrow at the extreme right
of the view.(IF) don't see
the difference

it's not updated in other
view

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

CriticalPath
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5.6

5.7

5.8

5.9

5.11

5.12

6.1

6.2

6.3

Zoom In/Out

Add Bookmark

Next/Previous marker

Delete bookmark

Do not show markers

Show markers

Synchronization

Time synchronization

Window range
synchronization

Selection range
synchronization

Click Zoom In/Out
button

Select a time, and
click on the Add
Bookmark button
Add more
bookmarks, then
click on the
next/previous
marker buttons

With next/previous
marker, when on a

bookmark, click
the delete
bookmark button
Click on the down
arrow at the
extreme right of
the view, then
expand Show
markers and
uncheck the
Bookmarks box
Same as above,
recheck the

Bookmarks box

Select a random
time in another
view

Select a new
window range in
another view

In any other view
that supports
selection range
synchronization,
select a new
range.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated
to other views.

The bookmark is added and is displayed in
the other views as well (if enabled)

The time graph view navigate between the
bookmarks, States are updated and time
selection is propagated to other views.
When on a bookmark, the Add bookmark
buttons changes to Delete bookmark

The bookmark is deleted from all views

All remaining bookmarks disappear from
the view, but remain in other views where
the they are enabled

' The bookmarks come back

Selected time line is updated. If selected
time is outside current range, time range is
updated to include it.

Window range is updated.

Selection is highlighted. If the left time (T1)
of selected time range is outside the current
range, then window range is updated to
include it

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

When there is no selection,
sometimes it zooms
relative to left of window.
(IF) i didn't have this issue

it doesn't show in the other
views

but i should add a
description

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation

Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

CriticalPath
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CriticalPath

With a critical path

displayed, select a

time in another

view that is not in

the range of the

process being

displayed in the Selected time is updated and the critical

Automation
6.4  Out of region selection critical path view  path view is synced with the other SWTBot

Candidate
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NetworkAnalysis

Section Pass Fail Automated To Do Comments
Network Trace Analysis 11 3 0 6
Target: Windows

Step Test Case Action Verification Type Comment

0 Prerequisites

0.1 Import traces Import the trace linked here which trace?
1 Trace Import
Open the Network Tracing Verify that the events view, the properties and Why LTTng?
1.1 perspective In the project Explorer, expand any pcap trace  stream list are displayed SWTBot Pass | Bernd: Updated
L. . In SWTBot other trace is used.
The trace is given a "network" icon. When opened, Histogram not in focus in manual mode
1.2  Open trace Double-click on the "TeamSpeak2.pcap” trace  the events view and stream list view are populated. SWTBot Pass | Bernd: Updated verification text

2 View management
Redundant with 1.2 above?

2.1  Populate the views Open the "TeamSpeak?2.pcap” The views are updated SWTBot Pass  |Bernd: Yes
One stream is available with endpoint A being 00:0c: Automation
2.2  Look up stream Open the Stream List view 29:7c:ab:f9 Manual Pass Candidate
2.3  Close the trace Close the trace The stream list is emptied Manual Pass
2.4  Close view Close the Stream List view The view is closed Manual Pass
Open view when trace is The view opens with the correct title and is correctly
2.5 already loaded Re-open the trace. Open the Stream List view  populated. Manual Pass

Should change the action to "open a non pcap
L . trace" instead of "close the trace"
2.6 Open a non pcap trace Open a non pcap trace The stream list is emptied Manual Pass | Bernd: Updated

3 Stream List

Open "TeamSpeak?2.pcap" trace and open Trivial test, to remove or amend?
3.1 Re-open trace Stream list view Stream list view populated Manual Pass | Bernd: It's a pre-req
Create a filter from the Right click on stream 0, and select "Extract as A filter named "FILTER stream eth 00:0c:29..." is
3.2  stream list Filter" created Manual Pass

In the events table, right click on an event and
select "Apply preset filter-> stream eth 00:0c:
3.3 Apply filter 29..." 24/24 events pass the filter Manual Pass

38


http://wiki.wireshark.org/SampleCaptures?action=AttachFile&do=get&target=TeamSpeak2.pcap

FlameGraphView

Section Pass Fail Automated ToDo Comments
Flame Graph View 11 0 5
Target: Windows

Step Test Case Action Verification Type Comment
1] Download the test resources Download this
1 Preparation
Verify that
'Flame Graph
Use menu Window — Show View — View' view is
1.1 Open TMF Flame Graph View Tracing — Flame Graph shown SWTBot
Verify that
Import a trace that does not have any call nothing is
stack information, like a standard kernel shown in the
1.2 Import generic trace trace view SWTBot
Verify that the
Flame Graph
View is
populated with
some
Import the trace in the "trace" directory of  callers/callees
1.3 Import cyg-profile trace the downloaded zip information. SWTBot
Verify that the
Flame Graph
View is
populated with
some
Import a trace in the "trace-fast" directory  callers/callees
1.4 Import cyg-profile-fast trace of the downloaded zip information. SWTBot

2 Manage View
Flame Graph'
view is removed
from
2.1 Close view Close the 'Flame Graph' View perspective SWTBot
Flame Graph'
view is
Use menu Window — Show View — Other displayed and
2.2  Open view ... — Tracing — Flame Graph re-populated SWTBot
Verify that view
is populated
with
callers/callees
2.3  Open Trace Open "trace(-fast)" trace information SWTBot
Verify that view
1) Close 'Flame Graph' view is populated
2) Open "glxgears-cyg-profile(-fast)" trace  with
located in the git in ctf test callers/callees
2.4  Open view when trace is already loaded 3) Open 'Flame Graph' view information SWTBot
Verify that view
is populated
with all
callers/callees
Open Experiment with 2 or more Flame information
Graph traces. (separated by
2.5 Open Experiment (You can use both traces) trace). Manual

Automation Candidate
Kyrollos: when mapping symbols for a trace in an
https://bugs.eclipse.org/bugs/show_bug.cqgi?id=512462 experiment both traces in the experiment got mapped
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https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing
https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462

FlameGraphView

Verify that view
is populated
with
Restart Eclipse with Flame Graph trace callers/callees
2.6 Restart opened from trace Manual
Verify that
Flame Graph
view is cleared
Close traces and experiment one by one  after closing the
2.7 Close all traces from the editor tab last trace Manual

Automation Candidate

3 Sorting
Open a trace multiple Flame Graph thread
or open experiment with 2 or more Flame  The view is
Graph traces. Then select 'Sort threads by sorted by thread
3.1 Thread name sorting thread name' name. Manual
Open a trace multiple Flame Graph thread
or open experiment with 2 or moreFlame  The view is
Graph traces. Then select 'Sort threads by sorted by thread
3.2 Thead id sorting thread id' id. Manual

Automation Candidate
Kyrollos: | don't know how to evaluate this since | don't
have the process id neither the thread name in the

https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462 tooltip but it seems not working

https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462 Automation Candidate

4 Synchronization
Selected time
line is not
updating.
Nothing
4.1  Time synchronization Select a random time in another view happen. Manual

- The 'flame
chart' view is
populated
- The flame
chart view is
synchronised to
the range of the

1. Open the 'flame chart' View maximum call

2. In the 'Flame Graph' view, right-click on duration of the

a random entry in the graph 'Flame Graph'

4.2  Go to maximum 3. Select 'go to maximum' selected entry Manual

- The 'flame
chart' view is
populated
- The flame
chart view is
synchronised to
the range of the

Automation Candidate

Hoang: You need a trace that has more than 1
occurence of function call in the same stack. Automation Candidate

1. Open the ‘'flame chart' View minimum call
2. In the 'Flame Graph' view, right-click on  duration of the
o a random entry n the graph 'Flame Graph' Kyrollos: | am not sure that | fully understand the
4.3  Go to minimum 3. Select 'go to minimum' selected entry Manual functionnality tested Automation Candidate

5 Function name import
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https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462
https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462

5.1

5.2

'Function name import

Mouse handling

Mouse hover (empty region)

Mouse hover (state)

1. Open the 'Call Stack’ view with the
'Flame Graph' view and the cyg-profile
trace opened

2. Import 'cyg-profile-mapping.txt' as

“mapping text file

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Both 'Call Stack'
and 'Flame
Graph' views
display function
name instead of
function

‘address.

Tool tip shows
depth only
Tool tip shows
Total time and
self times with
standard
statistics.

SWTBot

SWTBot

SWTBot

FlameGraphView
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HistogramView

Section Pass Fail Automated To Do Comments
TMF - Histogram View 21
Target: Windows

Stop _Test Case Action Verification Type Comment

1 Preparation
LTTng Kerel perspective opens with

11 Stept Open and reset LTTng Kemel perspective correct views SWTBot

12 Step2 Open an LTTng trace Views are populated SWTBot

2 Manage View
Histogram View is removed from

21 Close view Close the Histogram View perspective SWTBot 84710
Histogram View s dplayed and re-
22 Openview Window > Show View > Tracing > Histogram popul SWTBot 84710
H\stugrzms are
23 Resize Resize the Histogram View width-wise compressedidecompressed without loss  SWTBot Tested with HistogramDatabodefTest

3 Full Trace Histogram
Selection Start/End + blue bars are

31 Single selection Select timestamp with left-click updated Manual
Selection Start/End + blue bars are
32 Range selection Select time range with shift-left-click, shiftleft-drag or left-drag  updated Manual
window s dragged, won' go
33 Drag zoom window Drag the zoom window lefuight with ctri-left-drag or middle-drag beyond ful range Manual
m window is centered on click, won't
34 Move zoom window Move the zoom window with ctr-left-click or middle-click go beyond full range Manual
Zoom window is set, Window Span is
upda!&d won't go beyond histogram
35 Setzoom window Set a new zoom window with right-drag Manual
Zoom vindow s updated. Window Span
is updated, worf go beow 2, wort
36  Zoominlout Zoom inlout with mouse wheel up/down xceed full trace range Manual
Setecton (blue bar meves f the
37 Arrow keys Move the current event using leftright arrow keys previousinex non-empy bucket Manual Non empy bucket?

Selection Start/End mc
begminglend of racs (16 Sarttime of
38 Home/End keys Press Home/End key last bucket is selected) Manual
With a trace containing lost events, click the “Hide lost events™  The lost events (red bars) are toggled
39 Lostevents toolbar icon. Click it again. on and off. Manual
Zoom window is updated, Window Span
is updated, won't go below 2 ns, won't
310 Zoom inout (key) Zoom inout with +- key exceed ful trace range Manual
4 Time Range Histogram

bucket?

Use hello-ost n test races

Selection Start/End + blue bars are

41 Single selection Select timestamp with left-click updated Manual
Sekecon SirilEnd + s bers are

42 Range selection Select time range with shiftleft-click, shiftleft-drag or left-drag  upda Manual
m wlnduw .  draged, vor' g

43 Drag zoom window Drag the zoom window leftight with ctri-left-drag or middle-drag beyond full rar Manual

oo window 4 updated, Window Span
is updated, won't go below 2 ns, won't

44 Zoom inout Zoom infout with mouse wheel up/down exceed full trace range Manual
Selection (blue bar) moves to the
previous/next non-empty bucket, won't

45 Arrow keys Move the current event using leftiright arrow keys exced the zoom window Manual
Selection Start/End moves to
beginning/end of time range (i.. start

46 HomelEnd keys Press Home/End ke time of last bucket is selected) Manual

With a trace containing lost events, click the “Hide lost events™  The lost events (red bars) are toggled

47 Lostevents toolbar icon. Click it again. on and off. Manual
Zoom window is updated, Window Span
is updated, won't go below 2 ns, won't

340 Zoom infout (key) Zoom inout with +- key exceed full race range Manual

5 Selection Start/End

Won't exceed zoom windor
Bernd: Ack...not implamentod
Kyrollos: Indeed won't exceed zomm window

the zoom window

When TS is
51 Set selection start Enter a TS within the full range in Selection Start widget Selection Start + blue bars are updated  Manual e ramber corecty at s desin e
When TS is fower
< Selecion
52 Setselection end Enter a TS within the full range in Selection End widget Selection End + blue bars are updated  Manual Bema: I remember corectly,that was a design choice
Solect th ink con. Enter TS witin he ful range in Selecton  Selecion SartEnd + bus bars are
53 Setselection (inked) Start widget updated Manual
Selection Start + blue bar set to first
54 Setinvalid selection start Enter a TS before the full range start in Selection Start widget  event Manual
Selection End + blue bar set to last
55 Setinvalid selection end Enter a TS after the full range end i Selection End widget event Manual

6 Window Span
Both Histograms are pdated

61 Setwindow span Enter a span in Window Span widget accordin Manual
62 Setlarge window span Enter an invalid span (too large) in Window Span widget Span set Ia full range Manual
Enter an invalid span (too small, negative, not a number) in
63 Setinvalid window span Window Span widget Span set to previous value Manual tos:bugs eclipse orglougsishon bug cgi%id=550946
Selected Timestamp
7 hronization
Time Range mouse Click on the time range histogram. The time of the bucket at the  Other views are synchronized to the
74 synchronization mouse position is selected. selected time Manual
Click on the fulltrace histogram. The time of the bucket at the  Other views are synchronized to the
72 Full Trace mouse synchronization  mouse position is selected. selected time Manual
Select the link icon. Enter a time within the full range in Other views are synchronized 1o the
7.3 Selection synchronization (linked) ~ Selection Start widget selected time Manual NEED to verify lnk icon
Selection Start/End + biue bars in both
In any other view that supports time synchronization, selecta  histograms are updated to the selected
7.4 Extenal synchronization time. time Manual
Selected Time Range
8  Synchronization
Verify that the selected time range
Time Range mouse Solecta imo rango nthe smal Hstogram (shifetlic,lef-  shows in both histograms, and in other
81 synchronization drag or shiftleft drag). Manual

Verly hat th selectd time range
Select a time range in the full histogram (shiftleft click, left-drag, shows in both histograms, and in other

82 Full Trace mouse synchronization  shift-left drag). views. Manual
Selection Start/En Other views are synchorized t the
83 synchronization Enter a time within the full range in Selection StartEnd widget  selected time rang Manual
Selection SiarEnd + bue bars nboth
In any other view that supports time range synchronization,  histograms are updated to the selected
84 Extenal synchronization select a time range. time range. Manual Selecton may exceed histogram view
9 Zoom Window synchronization
Time Range mouse Select a zoom window in the small histogram (ctr-eft drag,  Other views are synchronized to the
91 synchronization middle-drag, right-drag, mouse wheel up/down). new range Manual
Select a zoom window in the full histogram (ctrHleft drag, Other views are synchronized to the
92 Full Trace mouse synchronization  middle-click, middle-drag, right-drag, mouse wheel upidown).  new range Manual
Other views are synchronized to the
93 Window Span synchronization  Enter a new span in Window Span widget new range Manual
In any other view that supports range synchronization, selecta  Window Span and both histograms are
94 External synchronization new zoom window. updated (o the new range Manual

10 Multiple Trace Synchronization
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https://bugs.eclipse.org/bugs/show_bug.cgi?id=550946

106
107

Preparation
Open muliple traces (no overiap)

Change selected time and range
(no overlap)
Open multiple traces (overlap)

Change selected time and range
(overlap)

Select other trace (overiap)

Trace coloring
Close all traces

1) Download traces zi
directory ${local

1
2) Import kernel trace ${local}/traces/import/kernel-overlap-

testing
3) Import UST ${local}traces/importitrace ust-overlap-
sting

4) Create experiment with trace of 2) in it

‘Open muliple traces that don't overlap in time

Select a time and new range
- Open multple traces that overlap in time

- For both traces, in Events table right mouse-click -> Follow

time updates from other traces

Select a time and new range

Select different trace by clicking its editor tab

With an experiment containing multple traces opened, click the
“Activate trace coloring" toolbar icon. Click it again.

Close all trace editor tabs

(if necessary) and unzi

View shows the last opened trace
Selection Start/End, Window Span and
both histograms are updated 1o selected
time and new range.

View shows the last opened trace
Selection Start/End, Window Span and
both histograms are updated to selected
time and new range.

updated to show selected trace.

both histograms are set to the newly
selected time and range.

“The colors in both Histograms are
toggled on and off. When itis toggled
off, the legend disappears at the bottom
and only one color is used for non-lost
events.

n
View is cleared.

Manual
Manual

Manual

Manual

Manual

Manual

Manual
SWTBot

Not sure fthe tests of secton 10 were done correcly:

HistogramView

Why the experiment step 4, with only one lrace? steps done: and
ot sure (which ones exactly and why? which view?)

Redundan test?

the trace that has Follow enabled.
(F) | didt see anything.
Selecting a range in one trace editor changes sibing trace's own.

Per above (related?) test.

Per above (related?) test.

The green fo the ust race gets removed when o

each trace.

traces
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Section
TMF - State System Explorer

Target: Windows

Pass
12

Fail

Automated To Do Comments

8

StateSystemExplorer

Step Test Case

1

1.1

2

21

2.2

23

24

25

27

26

2.7

w

3.1

3.2

£

4.1

4.2

Preparation

Open TMF State System Explorer View
Manage View

Delete view

Open view

Open Trace

Open view when trace is already loaded

Open Experiment

Select other trace
Restart

Close all traces

Timestamp / Time Range Selection
Select timestamp

Select time range

Displaying of Changed Values
Highlighting of changed values
“Only Display Changes at Selected

Timestamp” option with event selection

“Only Display Changes at Selected
Timestamp” with timestamp selection

Action

Use menu Window — Show View —
Tracing — State System Explorer

Close the State System Explorer' View
Use menu Window — Show View —
Tracing — State System Explorer

Open an LTTng Kernel Trace

1) Close State System Explorer View
2) Load LTTng trace

3) Open 'State System Explorer' view

Open Experiment with 2 or more LTTng
traces

Select different trace by clicking its Events
editor tab

Restart Eclipse
Close traces and experiment one by one
from the editor tab

Select time in another view (e.g Histogram
view) that supports time synchronization
Select a time range in another view that
supports time synchronization

Select many different timestamps one after
the other

Enable the “Only Display Changes at
Selected Timestamp” option with the
toolbar button. Select different Events from
the Event Table.

Enable the “Only Display Changes at
Selected Timestamp” option. Select
*timestamps* corresponding to state
changes (for example, using the
previous/next buttons in the Control Flow
View).

Verification

Verify that 'State System Explorer' view is shown

'State System Explorer' view is removed from
perspective

'State System Explorer' view is displayed and re-
populated

Verify that view is populated with kernel state
system (o.e.t.analysis.os.linux.kernel) and
statistics state systems (o.e.l.tmf.statistics.*) of
opened trace

Verify that view is populated with state systems
from trace

Verify that view is populated with all kernel state
system and statistics state systems of opened
experiment (separated by trace)

View is updated to show selected trace. State
values, start time and end time are updated
according to the selected trace's previously
selected range.

Verify that view is populated with state systems
from trace

Verify that state system explorer view is cleared
after closing the last trace

Verify that selection time is updated in view

Verify that selection time range is updated in view

Selection time bar is over the current time and
state value of Attribute is shown

Verify that only the state values that changed

because of that event are displayed.

Verify that only the state values that changed at
that timestamp are displayed.

SWTBot Pass

SWTBot

SWTBot

SWTBot

SWTBot

RCPTT

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

N/A

N/A

Comment

Some state systems ID's should be renamed for Trace
Compass

Bernd: Renaming IDs would make other plug-in extensions
of adopters fail. So, we can't really change it.

(if the state system were already built)

The values are only available for time ranges where the
trace exists. Only after we've "visited" other timestamps,
then the attributes show up and print "Out of range". http:
Ileclip.se/443653 Works now: matthew

Bruno : | find the separation weird, and sincce | never used
this view i'd like someone else to test this item. (Only the
items in the second trace are expendable)

Kyrollos: The state system/ Attributes are populated with
the right informations about the trace but the graph is
empty

Modifying "Selection End" entry in histogram view shows
the end time of the range on the state system explorer

Kyrollos: Not sure to fully understand this test Matthew:
select time areas, and the state is selected

Menu doesn't exist anymore because it's now an
AbstractTimeGraph view

Menu doesn't exist anymore because it's now an
AbstractTimeGraph view

Test that will make this swtbot

84711

84711

84711

84711

84711

Automation Candidate

Automation Candidate

It's an abstract time graph view

It's an abstract time graph view

Automation Candidate
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Section
LTTng 2.0 - Memory Analysis

Target: Windows

Step Test Case

0

0.3
0.4

-

22
23

24
2.5

Prerequisites

Download traces

Import trace with memory event

Import trace without memory event
Import non-UST trace

Project View

Check analysis can execute

Verify help message when applicable

Check analysis cannot execute

Pass

Action

Download UST trace with memory events
from https://secretaire.dorsal.polymtl.
ca/~gbastien/traces/eclipse_mem_ust.tar.
gz. Hung: | suggest downloading eclipse
trace

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for

example, the one used for the callstack view

Import one LTTng Kernel trace

open the trace that contains the memory
events. In the project explorer, expand the
trace that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,
right-click the memory analysis and select
Help

open the trace that does not contain the
memory events. In the project explorer,

expand the UST trace that does not contain

memory events
In the project explorer, open and expand

Fail

Verification

"Ust Memory" analysis is present and "normal"

A generic help message appears with the name of the
analysis.

"Ust Memory" analysis is present, but striked-out

the UST trace that does not contain memory The help message mentions the analysis is impossible

events, right-click the memory analysis and

Verify help message when not applicable select Help

Check analysis for another trace type
View Management

Populate analysis's view

Open view

Close trace

Open trace
Close view

Re-open view

In the project explorer, expand a LTTng
Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view
Double-click the UST Memory Usage view
under the memory analysis in project
explorer.

to execute and contains the requirement that is not
fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis
The UST Memory Usage view opens and triggers the
memory analysis. After the analysis, the XY chart is
populated

The UST Memory Usage view is emptied.

The UST Memory Usage view is populated.
The view is closed.

The view opens and is automatically populated.

LTTng 2.0 - Memory

Automated To Do Comments

8 0
Type
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass

5

Comment

but if the trace is not open the ust analysis in not
striked-out

Bernd: Yes, the information that a trace contains
certain events is only know when opening the
trace and reading the metadata file (since it's a
LTTng trace). Without opening the project
explorer won't know whether to strikethrough or
not.

it's not the same message

Bernd: The verificaiton text just describes what
to expect and not the exact help text that is
being displayed)

Automation
Candidate

Automation
Candidate
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3.1

3.2

3.3

34

3.5

3.6

3.7

3.8

4.1

4.2

4.3

Mouse handling

Drag move time range

Zoom time range (mouse wheel)

Drag select time range
Mouse hover

Drag mouse selection

Shift key selection

Drag mouse selection (Status bar)

Shift key selection (Status bar)
Synchronization

Preparation

Time synchronization
Time range synchronization

Time range selection synchronisation

Drag move xy chart left and right with
middle button

Zoom with CTL + mouse wheel up and
down, cursor inside xy chart

Drag select time graph with right button
Hover mouse in xy chart anywhere

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Have the Histogram and UST Memory
Usage views both visible

Select a random time in another view
Select a new time range in UST Memory
Usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Time range is dragged. When mouse button is
released, the view refreshes with the new time range

Time range is zoomed in and out, relative to mouse
cursor. When mouse wheel is stopped for a short time,
series are updated and new time range is propagated
to other views.

Selection highlighted. When mouse button is released,
time range is zoomed to selection, series are updated
and new time range is propagated to other views.

Tool tip shows values for each thread at the given
timestamp

Selection highlighted. New selection is propagated to
other views

Selection highlighted. New selection is propagated to
other views

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be
negative)

Selected time line is updated.
Time range is updated.

Selection range is highlighted.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

LTTng 2.0 - Memory

Until the mouse is released, the Ul is not

updated. Automation
Bernd: That's exactly it. Candidate
When you zoom in and a series was checked

but it is now filtered out, when you zoom out you

lose you checked series

Bernd: Ack.

Kyrollos: When you zoom in some process Automation
names disappear from the table on the left Candidate

Time range change could be seen in the kernel  Automation
perspective view Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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Section
LTTng 2.0 - Resources View

Target: Windows

Step Test Case

0

0.1

0.2

=y

1.1

1.2

1.2
1.3

1.4

2.2

2.3

3.1

3.2

3.3

3.4

3.5

Prerequisites
Import traces
Create experiment
View management

Open perspective

Open trace

Open experiment
Close view

Open view
View selection

Select resource in time graph

Select state in time graph
Mouse handling

Drag move canvas

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Vertical scroll bar

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective,
and select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer
Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Drag move time graph left and right with
middle button

Ctrl+mousewheel in the time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down, cursor
outside time graph (in name space)

Click and drag vertical scroll bar

Verification

Resource view opens.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.
View is closed.

Resources view is opened and populated with
processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is
released, states are updated and new window
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

Time graph scroll up and down and remain
aligned. Selected process does not change.

Automated ToDo Comments

Type

Manual

Manual

SWTBot

SWTBot

Manual
SWTBot

SWTBot

Manual

Manual

SWTBot

Manual

SWTBot

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

LTTng 2.0 - Resources

Comment

LTTng Kernel traces is Linux Kernel trace in Trace Compass

Automation
Candidate

Automation
Candidate

Automation
Candidate
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3.6

3.7

3.8

3.9

3.10

3.1

4.1

4.2

5.1

5.2

53

5.4

5.5

5.6

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection
Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph
(state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out

Filter Dialog

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,

HOME, END keys

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next State button

Click Previous/Next Process button

Click Zoom In/Out button

Open Filter Dialog

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ name is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state, CPU
is shown.On usermode and syscall tool tip
shows also shows TID and process name. For
syscall the system call name is shown as well
as the kernel callsite (if available).

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

nanatival

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to

Verify that all buttons are working correctly

LTTng 2.0 - Resources

Automation
Manual Candidate
Automation
Manual Candidate
Manual
IRQ_ACTIVE is renamed to INTERRUPT in Trace Compass.
Failured since there is no hover time property in the tooltip. It
is not yet determined if this is a bug, or if the test needs to be
updated.
Bernd: | don't think it's a bug. There is no hover time shown.
The verification text needs to be updated to be clearer. Automation
Manual Updated and set to pass. Candidate
SWTBot
Manual
SWTBot
SWTBot TimeGraphViewTest
SWTBot TimeGraphViewTest
SWTBot TimeGraphViewTest
SWTBot TimeGraphViewTest
Automation
Manual Hoang: | think this means next resource Candidate
Time range is zoomed relative to selected time. If there is no
selected time, it is sometimes zoomed relative to left of
SWTBot window
SWTBot TimeGraphViewTest
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6 Synchronization
Selected time line is updated. If selected time
is outside current range, time range is
6.1  Time synchronization Select a random time in another view updated to include it. Manual
Select a new time range in Control Flow view
6.2  Time range synchronization or in Histogram view. Time range is updated. Manual
Selection is highlighted. If begin time (T1) of
Time range selection In any other view that supports range selected time range is outside the current
6.3  synchronisation synchronization, select a new range. range, then time range is updated to include it ~ Manual
7 Multiple Trace Synchronization
1) Download traces.zip (if necessary) and
unzip into a local directory ${local}
2) Import kernel trace ${local}
ltraces/import/kernel-overlap-testing
3) Import UST ${local}/traces/import/trace
ust-overlap-testing
Preparation 4) Create experiment with trace of 2) in it Manual
Open multiple traces that don't overlap in
time. For each traces, click on the Events View shows the last opened trace. The Follow
table and select Follow time updates from time updates from other traces option in the
7.1  Open multiple traces (no overlap) other traces Context menu of the Events table is selected. Manual
Change selected time and range Selected time line and time range is updated
7.2  (nooverlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Selected time line and time range are restored
Select different trace by clicking its Events to the selected trace's previously selected
7.3  Select other trace (no overlap) editor tab time and range. Manual
Open multiple traces that overlap in time.
For each traces, click on the Events table View shows the last opened trace. The Follow
and select Follow time updates from other time updates from other traces option in the
7.4  Open multiple traces (overlap) traces Context menu of the Events table is selected. Manual
Change selected time and range Selected time line and time range is updated
7.5 (overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Select different trace by clicking its Events Selected time line and time range are set to
7.6  Select other trace (overlap) editor tab the newly selected time and range. Manual
7.7  Close all traces Close all Events editor tabs View is cleared. SWTBot
8.1 Filtering [
Preparation Open 2 LTTng Kernel Traces Manual
8.1  Apply filter (1st trace) 1) Open filter dialog Make sure that only selected processes of SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2  Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3  Persistent filter Switch between both open traces available Manual
9 Miscellaneous
1) Open LTTng Kernel Trace
2) Select Resource View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Resources View is populated Manual

LTTng 2.0 - Resources

Automation
Candidate

Automation
Note: Time range means window range, time selection! Candidate
Note: Time range means window range, time selection!
The point of this test case is that the selection range is drawn
correctly when the time range is change. Depending how the

selection range and time range intesect, the selection range is  Aytomation

drawn. _ Candidate

Kyrollos: Time range is not updated to include T1 nor T2 in

Resources view
Automation
Candidate
Automation
Candidate
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Section
TMF - Remote Fetching

Target: Eclipse on macOS 12.3

Step Test Case

1

1.1

2

34
3.5

3.7
3.8

Preparation

Step 1

Opening

Open Profile Editor 1
Open Profile Editor 2

Edit Profile - Add/Delete

Create Profile
Add Node
Add trace group

Add trace
Delete Trace

Delete Trace Group

Delete Connection Node
Remove Profile

Edit Profile - Reorder

Move profile up/down

Move connection node up/down

Move Trace Group up/down

Move Trace up/down

Edit Profile - Copy, Cut, Paste

Copy/Paste Profile

Pass

Action

Open Trace Compass and reset Lttng
perspective

Right-click on Traces Folder -> Fetch Remote
Traces ... -> Manage Profiles

Window -> Preferences-> Tracing -> Remote
Profiles

Open Profile Editor > Click on 'Add" > Enter
profile name, remote information, root path and
trace pattern

Select Profile node > right mouse click > select
‘New Connection Node'

Select node node > righ mouse click > select
'New Trace Group'

Select trace group > right mouse click > select
'New Trace'

Select trace > right mouse click > select Delete
Select Trace Group> right mouse click > select
Delete

Select Connection Node > right mouse click >
select Delete

Select Profile > click on 'Remove' button

Create at 2-3 profiles > select 2nd profile and
press buttons 'Move Up'/'Move Down'
Make sure that there are 2 or 3 connection

Fail

Verification

Lttng perspective opens with correct views

The Profile Editor of preference page opens

The Profile Editor of preference page opens

New Profile is created and template is
provided

New Connection Node is create under the
profile and template is provided

New Trace Group is created under the node
and template is provided

New Trace is created under Trace Group and
template is provided

Trace is deleted

Trace Group is deleted

Connection Node is deleted
Profile is deleted

Profiles are moved up and down

nodes > select 1 connection node > click buttons Connection Nodes are moved up and down

'Move Up'/'Move Down'

Make sure that there are 2 or 3 trace gropus >
select 1 trace group > click buttons 'Move
Up'/'Move Down'

Make sure that there are 2 or 3 trace groups >
select 1 traces > click buttons 'Move Up'/'Move
Down'

Select Profile > click right mouse button on a
profile > Select Copy -> click right mouse button
on other profile > Select Paste

within a profile

Trace Groups are moved up and down within
a connection node

Traces are moved up and down within a Trace
Group

Profile is pasted under the selected profile

RemoteFetching

Automated ToDo Comments

51 0
Type
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
RCPTT Pass
RCPTT Pass
SWTBot Pass
RCPTT Pass
RCPTT Pass
RCPTT Pass
SWTBot Pass
RCPTT Pass

18

Comment

Bruno : Not this test, but the Fetch Remotes Traces dialog,

has a help button that does nothing. Patrick: See Bug
440238.
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52

5.3

5.4

5.5

5.6

5.7

5.8
5.9

6.1

6.2

6.3

6.4

6.5

6.6

6.7

6.8
6.9

71

7.2

7.3

8.1

Copy/Paste Profile (Keys)

Copy/Paste Connection Node
Copy/Paste Connection Node
(Keys)

Copy/Paste Trace Group
Copy/Paste Trace Group (Keys)
Copy/Paste Trace

Copy/Paste Trace (Key)
Cut/Paste

Edit Profile - Adverserial
Error empty profile name

Duplicate profile name

Error empty Connection node
name

Duplicate Connection node name
Missing username in URI

Invalid URI

Error empty Trace Group

Error empty Trace
Invalid File pattern

Export/Import Profile
Export Profile
Import Profile

Import Profile

Remote Fetch Wizard

Preparation

Redo 5.1 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a
Connection Node > Select Copy -> click right
mouse button on other Connection Node >
Select Paste

Redo 5.3 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a
Trace Group > Select Copy -> click right mouse
button on other Trace Group > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a
Trace > Select Copy -> click right mouse button
on other Trace > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys
Redo 5.1 - 5.8 with cut and paste

Clear profile name
Add profile with name of existing profile

Clear Connection node name
Within a profile, add Connection node with name
of existing node

remove user name of a Connection Node

add invalid URI
Delete Trace Group root path

Delete File Pattern
Add trace with invalid regular expression

Select multipe profiles > Click Export Button >
Select Folder and enter file name > OK

Click on Import Button > select profile XML file >
OK

Redo 7.2

1) Generate CTF trace in
<plugin>/generated/synthetic-trace

2) Import profiles from <plugin>/profiles/test-
profiles.xml

Profile is pasted under the selected profile

Profile is pasted under the selected
Connection Node
Profile is pasted under the selected
Connection Node

Profile is pasted under the selected Trace
Group
Profile is pasted under the selected Trace
Group

Profile is pasted under the selected Trace
Profile is pasted under the selected Trace
Successful cut and paste

Error message "Profile must not be empty"
Error message "<name>: Duplicate profile
name"

Error message "Node name must not be
empty"

Error message "Duplicate node names"

Error message "URI must include user
information"

Error message "URI must include valid host
and port number" or "Unsupported URI
scheme"

Error message "Root path must not be empty"
Error message "File pattern must not be
empty"

Error message "Invalid file pattern”

Only selected profiles are exported

Profiles are imported
after second import an error message appears
"Duplicate profile names"

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT
RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT
RCPTT

SWTBot

SWTBot

SWTBot

SWTBot

Trace (5.7) is done with SWTBot

RemoteFetching
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8.2

8.3

8.4

8.5

8.6

8.7

8.8

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory)

Clear traces

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory), only 1
trace selected

Clear traces

Run Profile "TestAllRecursive"

Re-run Profile "TestAllIRecursive"
(Rename)

Re-run Profile "TestAllIRecursive"
(Overwrite)

Re-run Profile "TestAlIRecursive"
(Skip)

Re-run Profile "TestAllIRecursive"
(Overwrite 2)
Clear traces

1) Create Profile with Local connection, 1 trace
group (root /tmp/traces/) and 2 traces (.*syslog.*
and .*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on 'Next' button

4) Click on 'Finish’

Delete all traces from Traces directory

1) Create Profile with Local connection, 1 trace
group (root /tmp/traces/) and 2 traces (.*syslog.*
and .*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on 'Next' button

4) deslect the synthetic CTF trace

5) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

4) In dialog box select 'Rename’ for the first trace
and 'Rename ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

4) In dialog box select 'Overwrite' for the first
trace and 'Overwrite ALL' for the second traces
1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

4) In dialog box select 'Skip' for the first trace
and "Skip ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Select checkbox 'Overwrite traces without
warning'

3) Click on 'Next' button (enter password if
needed)

4) Click on 'Finish’

Delete all traces from Traces directory

Verify that all test traces are imported with
correct trace types assigned. Verify that folder
structure is preserved.

All traces deleted

Verify that only the selected traces are
imported with correct trace types assigned.
Verify that folder structure is preserved.

All traces deleted

Verify that all test traces are imported with
correct trace types assigned (LTTng kernel,
LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with
unrecognized trace type. Make sure that
directory structure is preserved.

Verify that all test traces are imported with
new name and correct trace types assigned
(LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is
importeds with unrecognized trace type.
Make sure that directory structure is
preserved.

Verify that all test traces are imported with
correct trace types assigned where old traces
are overwritten. (LTTng kernel, LTTng UST,
custom text, custom XML). The file
unrecognized.log is importeds with
unrecognized trace type. Make sure that
directory structure is preserved.

Verify that all test traces are skipped and no
trace is imported

Verify that all test traces are imported with
correct trace types assigned where old traces
are overwritten (no dialog box opens). (LTTng
kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds
with unrecognized trace type. Make sure that
directory structure is preserved.

All traces deleted

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

RemoteFetching
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8.9

8.10

8.1

8.12

8.13

8.14

8.15

Re-run Profile "TestAllIRecursive'
(2)

Clear traces

Run Profile
"TestAlINonRecursive"

Clear traces

Run Profile
"TestSpecificRecursive"
Clear traces

Run Profile
"TestSpecificNonRecursive"
Clear traces

Run Profile
"TestSpecificMutliGroupRecursiv
e

Clear traces

Cancel Import
Clear traces

Run Profile "TestMultiNodes"

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Finish' (enter password if needed)
Delete all traces from Traces directory

1) Select profile "TestAlINonRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestSpecificRecursive" in Fetch

Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificNonRecursive" in
Fetch Remote Traces wizard (Remote Profile
page)

2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile
"TestSpecificMultiGroupRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

4) Cancel import (red square or Cancel button)
Delete all traces from Traces directory

1) Select profile "TestMultiNodes" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish'

Verify that all test traces are imported with
correct trace types assigned. The second
page is omitted. (LTTng kernel, LTTng UST,
custom text, custom XML). The file
unrecognized.log is importeds with
unrecognized trace type. Make sure that
directory structure is preserved.

All traces deleted

Verify that only traces from root path are
imported (LTTng kernel, LTTng UST, custom
text, custom XML). The file unrecognized.log
is importeds with unrecognized trace type.
Make sure that directory structure is
preserved.

All traces deleted

Verify that only kernel and custom text/XML
logs are imported from root and subdirectory.
Make sure that directory structure is
preserved.

All traces deleted

Verify that only kernel and custom text/XML
logs are imported from root directory only.
Make sure that directory structure is
preserved.

All traces deleted

Verify that only traces from root path are
imported (LTTng kernel, LTTng UST, custom
text, custom XML). Make sure that directory
structure is preserved.

All traces deleted

Verify that import operation is cancelled

All traces deleted

Verify that only traces from root path are
imported (LTTng kernel, LTTng UST, custom
text, custom XML). The file unrecognized.log
is importeds with unrecognized trace type.
Make sure that directory structure is
preserved. 2 nodes directories are created
with the above traces stored

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

RemoteFetching
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9.1

9.2

10
10.1

10.2

Connection Handling

Error cannot connect to remote
host (node doesn't exist)

Error cannot connect to remote
host (wrong password)

Other Remote Backends
Clear traces

Remote Fetch using SSH

Create profile with IP address that cannot be
connected to and run profile

Create profile with valid IP address. When asked
for password enter invalid password

Delete all traces from Traces directory

Update profile with local username and run test
9.2 entering the correct password

Operation to connect to remote node fails and
error dialog is shown with detailed information
(after time-out)

Operation to connect to remote node fails with
time-out and error dialog is shown with
detailed information. Note time-out is as per
remote development preferences

All traces deleted

Verify that all test traces are imported with
correct trace types assigned (LTTng kernel,
LTTng UST, custom text, custom XML). The
file unrecognized.log is imported with
unrecognized trace type. Make sure that
directory structure is preserved.

SWTBot

Manual

Manual

Manual

RemoteFetching

Local macOS behaviour is to re-prompt again for password.
Bernd: Trace Compass using the ssh remote capability of
another eclipse project. The password behaviour is
determined by that implementation.

Not sure how to properly cover the unrecognized case here.
Bernd: any text file that is not a trace will do.
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Section
LTTng 2.0 - Control Flow View

Target: Windows

Step Test Case

0

1.2
1.3

Prerequisites
Import traces
Create experiment

View management
Open perspective

Open trace

Open experiment
Close view

Open view
View selection
Select process in table

Select process in time graph

Select state in time graph
Mouse handling

Drag move chart area

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Vertical scroll bar

Pass

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer
Close the Control Flow view

Open the Control Flow view
Select a process in the table

Select a process in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down, cursor
inside time graph while holding the Ctl button

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down

Click and drag vertical scroll bar

Fail

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.
View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table. Selected
time line is updated. Other views are
synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line is
updated. Other views are synchronized to
selected time.

Visible range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change. Vertical scroll bar updated.

Table and time graph scroll up and down and

remain aligned. Selected process does not
change.

Automated To Do Comments

Type

Manual

Manual

SWTBot

SWTBot

Manual
SWTBot

SWTBot

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

13

Comment

The name of the test trace type is wrong, should be Linux Kernel trace
instead.

what do you mean by state?

LTTng 2.0 - ControlFlow
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3.6

3.7

3.8

3.9

3.1

4.1

4.2

5.1

52

5.3

54

55
5.6

5.7

5.8

5.9

Drag zoom time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection
Keyboard handling

Keyboard navigation in time graph

(process selection)

Keyboard navigation in time graph
(state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

Filter Processes

Hide Arrows

Follow CPU Forward

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

Click Reset Time Scale button

Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button
Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Click Hide Arrows button

With focus on time graph, click Follow CPU
Forward button

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows process name only.

Tool tip shows process name, state name,
date, start time, stop time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

nanatival

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selected process is changed. Table selection
is updated. Vertical scroll bar updated.
Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to

Verify that all buttons are working correctly

Verify that only selected processes are
displayed in the view

Verify that arrows are not drawn in the time
graph

Time graph is updated to show the next state
for this cpu following the arrow, the event is
selected in the Events editor.

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual
SWTBot

SWTBot

Manual

SWTBot

LTTng 2.0 - ControlFlow

Removes focus on time graph

don't show state name. Still no state name in 8.1
Kyrollos: Not all the informations are displayed: For syscalls the cpu and
system calls are not shown test need to be updated

Matthew: it shouldn't be possible to zoom in when window span is
000.000 000 002 but we can zoom until 000.000 000 001. Hoang: Still an
issue in 8.1, but not breaking. Kyrollos: Still an issue
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5.1

6.1

6.2

6.3

6.4

71

7.2

7.3

7.4

75

7.6
7.7

Follow CPU Backward

Optimize

Re-Optimize

Go to next event of selected thread

Go to previous event of selected
thread

Synchronization

Time synchronization

Event synchronization

Window range synchronization

Selection range synchronization
Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range
(no overlap)

Select other trace (no overlap)

Open multiple traces (overlap)
Change selected time and range
(overlap)

Select other trace (overlap)
Close all traces

With focus on time graph, click Follow CPU
Backward button

Click on the optimize button

Click on the optimize button a few more times

Select a thread and click on go to next event
of selected thread

Select a thread and click on go to previous
event of selected thread

Select a random time in another view

Select a state-impacting event
(sched_switch, syscall, ...) in events table or
in Resources view using Select
Previous/Next event.

Select a new window range in Resources
view or in Histogram view.

In any other view that supports selection
range synchronization, select a new range.

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace ${local}
Itraces/import/kernel-overlap-testing

3) Import UST ${local}/traces/import/trace
ust-overlap-testing

Open multiple traces that don't overlap in
time. For each trace, right click on the Events
table and select Follow time update from
other traces

Select a time and new range

Select different trace by clicking its Events
editor tab

Open multiple traces that overlap in time. For
each trace, right click on the Events table and
select Follow time update from other traces

Select a time and new range

Select different trace by clicking its Events
editor tab
Close all Events editor tabs

Time graph is updated to show the previous
state for this cpu following the arrow, the
event is selected in the Events editor.

verify that the processes are closer together.

verify that the processes did not move, the
optimization is stable

Verify in the events table that the selected
thread is the same as the previous event

Verify in the events table that the selected
thread is the same as the previous event

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it and view doesn't zoom

In addition to updating the selected time, the
process containing the state change is
selected and revealed. Vertical scroll bar is
updated if necessary.

Window range is updated.

Selection is highlighted. If the left time (T1) of
selected time range is outside the current
range, then window range is updated to
include it

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are restored
to the selected trace's previously selected
time and range.

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are set to
the newly selected time and range.

View is cleared.

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
SWTBot

Kyrollos: Need validation. Hoang: Check TID column in event editor to
make sure that we are still looking at the same thread.

LTTng 2.0 - ControlFlow

(Matthew) current range change the place but doesn't zoom or zoom out

to include all selected time line.
(Hoang) Test needs to be updated? Kyrollos: yes test need to be
updated

Bernd: | can't reproduce it. It works for me.
Kyrollos: | confirm T1 is included but the window is not zoomed out

Kyrollos: Not sure do you mean to open traces that overlap? | think that
the description need to be updated

(Matthew) If T1 is outside of the Window range, the range is not updated.
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LTTng 2.0 - ControlFlow

8.1 Filtering
Preparation Open 2 LTTng Kernel Traces Manual
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1  Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2  Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3  Persitent filter Switch between both open traces available Manual
9 Miscellaneous
1) Open LTTng Kernel Trace
2) Select Control Flow View
9.1  Restart (Bug 409345) 3) Restart Eclipse Verify that Control Flow View is populated Manual
1) Open LTTng UST trace while CFV is open Verify that Control Flow View is empty, current
9.2  Select single time (Bug 477009) 2) Select event in events table window range stays change to ensure visibility =~ Manual
1) Open Control Flow view, Resources view
and a kernel trace. Initial window range is
range 1'.
2) Go "right one page" on Control Flow view
by pressing right arrow in scroll bar.
3) Go "left one page" on Resources view by
Window range synchronization pressing left arrow in scroll bar. Verify that after each step the initial window
9.3 (Bug477012) 4) Go "right one page" on Control Flow view. range doesn't change Manual

Kyrollos: The filter applied to the respected trace appears on the right
trace and doesn't apply to other ttraces

Filter is undone

need verification

Kyrollos: Not sure to understand the verification needed to be done what
| observe is: time range in the window stay the same but time interval
changes to include the selectted event

Test on Windows.

automation candidate
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Section
TMF - Sequence Diagram

Target: Windows

Step Test Case

1

1.1

1.2

1.3

N

22

w

3.2

>

4.1

4.2

4.3

5

Preparation

Open perspective
Open TMF Sequence
Diagram View

Create and open
experiment with sequence
diagram data

Manage View
Close view

Open view when
experiment/traces is
already loaded

Tooltip

Hover over interaction

Pass

Action

1) Download traces.zip (if necessary) and unzip
into a local directory ${local}

2 )Use traces simple-server-thread1 and simple-
server-thread2 under traces/import/ for test cases
below

Open and reset LTTng Kernel perspective
Use menu Window — Show View — Other ... —
Tracing — Sequence Diagram

1) Create Tracing Project

2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread1 and simple-
server-thread2

4) Add these 2 traces to experiment

6) Open (double-click on) the experiment

Close Sequence Diagram view

1) Close 'Sequence Diagram' View
2) load sequence diagram experiment
3) Open Sequence Diagram view

1) Goto to first page (no selection of any interaction or
lifeline) 2) Hover over first interaction (arrow or

1) Goto to first page

Hover over interaction after 2) select first interaction

selection

Hover over time
compression bar

View Synchronization

Selection of interaction

3) Hover over 3rd interaction

Hover over first element in time compression bar on
the left of the view

Select an interaction in the 'Sequence Diagram'

Selection of event in events Select an sequence diagram event in the events table

table

Selection of new time
range

View Actions

(type SEND or RECEIVE)

Change time range in 'Histogram View'.

Fail

Verification

LTTng Kernel perspective opens with
correct views:
Project Explorer, Control, Control

Verify that 'Sequence Diagram' view is
shown

Verify that sequence diagram was
loaded. The interaction show the
signal numbers (Note that trace
doesn't contain strings for the
interactions. A special parser would be
necessary to map signal number to
trace)

Sequence Diagram View is removed frc

Verify that sequence diagram was
loaded. Verify that all 17 pages are
loaded.

Verify that tooltip appears with content
with interaction name and time stamp

Verify that tooltip appears with content
with interaction names and time stamp
delta between selected interaction and
interaction that was hovered over

Verify that tooltip appears with delta
and graph to show where delta is in
relation to current configured min max

Verify that interaction is highlighted in
'‘Sequence Diagram' view. Verify that
in the events table the corresponding
event is selected. Verify that time
Verify that corresponding interaction is
selected in the 'Sequence Diagram'
Verify that the content of the
‘Sequence diagram' changes and the
interactions are part of the new
window range

Automated To Do Comments

Type

SWTBot

SWTBot

Manual

Manual

Manual

UlTest

UlTest

UlTest

UlTest

UlTest

UlTest

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

13

Comment

Note: Ul tests are not SWTBot, but JUnit tests. Tests
are triggered programmatically right below the dialogs
level

Difficult to get the numb of pages. (IF) not sure. Hoang:
Click on the vertical dots toolbar icon, then select pages,
you should be able to view the number of pages.

Tooltip backgound is very dark and text is hard to read
on Ubuntu 14.10, 16.10 with default theme

how to run Ul tests

SequenceDiagram
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5.1

5.2

5.3

5.4

55

5.6

5.7

5.8

5.9

5.10

5.11

5.12

5.13

5.14

Test page navigation

Test menu item 'Pages..."

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Reset zoom

Use buttons and menu items 'Go to next page', 'Go to
previous page', 'Go to last page' and 'Go to first page'
to navigate through trace. Use also menu item

'Pages..." to jump to specific page

1) Select menu item 'Pages..."
2) In text box type “9”
3) Click on 'OK'

Goto to page 1 —

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1 —

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse

2) open find dialog

1) Select 'Sequence Diagram' view

2) press CTRL+f

Goto to page 1 —
1) Use menu item 'Hide Patterns...'
2) Press Add

3.1) select Interactions and deselect Lifeline

3.2) type regular expression 10.*03
4) Press 'Create’
5) Press 'Ok’

Goto to page 9 —
1) Use menu item 'Hide Patterns...'
2) Press Add

3.1) select Lifelines and deselect Interactions

3.2) type regular player2
4) Press 'Create’
5) Press 'Ok’

1) Apply one filter

2) Use menu item 'Hide Patterns...'
3) deselect filter

4) click 'Ok’

1) Restart eclipse

2) open hide dialog

1) Use button and menu item for zoom-in to activate

zooming in
2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to

selection mode
2) select an interaction

1) Use button and menu item for zoom-out to activate

zooming out
2) click into sequence diagram view

1) Use button and menu item for 'Reset zoom factor' to

reset the zoom level

Verify that different time ranges are
selected when changing page by
looking at Histogram View. Histogram
View window will show the start of the
page. Note that there are 10000
interactions per page. In this traces
thara ara in tatal 1ANN22 intarartinne
Verify that a dialog box will show.
Verify that for this trace it shows 'Total:
17 pages is shown” and the current
page is displayed in the text box. After
step 3) verify that page where

N

Anmad ta nama O Ear thin trann nana

After 4) verify that interaction 10000
(player1 — master) is selected. After
5) verify that interaction 10100 (master
— player1) is selected. After 6) verify
that 10000 (player2 — master) is
selected. After 7) verify that interaction
10100 (master — player2). After 8
nothing else will be found

After 4) verify that lifeline with name
player2 is selected (page 9 with 3
lifelines). After 5) player2 is selected
on page 10

Verify that previous used find criteria
are still in the list

Verify that find dialog opens

After 5) verify that Interactions with
name 10003 and 10103 are not shown

After 5) verify that player2 is not
shown

Verify that all lifelines and interactions
are shown

Verify that previous used hide criteria
are still in the list

Verify that 'Sequence Diagram' view
zooms in. Note that no selection is
possible.

Verify that selection is possible.
Verify that 'Sequence Diagram' view
zoom out. Note that no selection is
possible.

Verify that 'Sequence Diagram' view
goes back to default zoom

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SequenceDiagram

if find dialog is already oppen and do ctrl+f another find dialog is

Kurallne: 41 ic it narmal?




5.15

5.16

5.17

5.18

5.19

5.20

5.21

5.22

5.23

5.24

5.25

1) Select menu item 'Configure Min Max'
2) Change min to 100 and max to 2000 (keep scale
and precision)

Configure min/max 3) press 'Ok’

After changing min and max

1) select menu 'Configure Min Max'

2) press 'Default' 3) press 'Ok’

Goto to page 1 —

1) Resize view so that the arrow of the interaction is
not shown

2) select on interaction

Configure min/max
(default)

Show node end

Goto to page 1 —

1) Resize view so that the beginning of the interactions
are not shown

2) select on interaction

3) Use menu item Navigation — Show node start

Goto to page 1 —

1) Resize view so that the arrow of the interaction is
not shown

2) select on interaction

3) Press SHIFT+ALT+END

Show node start

Show node end short-cut

Goto to page 1 —
1) Resize view so that the arrow of the interaction is
not shown
2) select on interaction
Show node start short-cut  3) Press SHIFT+ALT+HOME

Scroll down short cut Press SHIFT+ALT+ARROW_DOWN

Scroll up short cut Press SHIFT+ALT+ARROW_UP

Goto page 9 — Keep pressing + icon at the lowest

Overview feature right corner of the view and drag down, up, left or right
Select 'Sequence Diagram' view and press printer icon
in the Eclipse's tool bar (or use CTRL+P). Select one

Print pager page to print

1) Create 1 filter ("Hide Patterns") if necessary (see

2) Open Error Log view if necessary
3) Open filter dialog box and remove all filters
4) Press 'Ok’

Remove filter (Bug 391714) 5) Open filter dialog box again

After 1) verify that a dialog box shows
with default values. After 3) verify that
time compression bar changes some
colors. It will show more deeper red
After step 2) the default values are
shown. After step 3) the time
compression bar will change colors.
Note that the default values are

S A R TR S PRS-

Verify that end lifeline of the
interaction (the arrow) is shown

Verify that start lifeline of the
interaction is shown

Verify that end lifeline of the
interaction (the arrow) is shown

Verify that start lifeline of the
interaction is shown

Verify that within a page the display
scrolls down per view size

Verify that within a page the display
scrolls up per view size

Verify that it's possible to navigate
through a page of the sequence
diagram view

Verify that it is possible to print

Verify that no exceptions occurred and
after 5) no filter are listed

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Not sure to fully understand what to do and what to expect. Here is
a picture of what | get:

https://drive.google.com/file/d/1-
FgNUPIAXnZjQS5DE83EX7QZsk90Rv-8/view?usp=sharing

Can we update the previous test with the 3rd step from this one?

The shortcut is not working when the mouse is hovering
the interaction as seen in the previous version 4.0.0
Kyrollos: +1. Hoang: Working in 8.1.0

The shortcut is not working when the mouse is hovering
the interaction as seen in the previous version 4.0.0
Kyrollos: + 1. Hoang: Working in 8.1.0

Key combination on Ubuntu 12.04 is used for something
else. This can be disabled using the combiz-settings-
manager (http://askubuntu.com/questions/171489/how-

On Ub-untu,' the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is
a visible empty space that is clickable in its place.
Clicking on it brings up the overview box which has a
reasonable size but movement is still hectic. On
windows the movement is hectic and the overview box is
very narrow and if i want to go up or down it don't work.

Bug 436442. Kyrollos: | don't see the + icon on Ubuntu.
The movement is not smooth and is not intuitive.

The dialog is confusing on Ubuntu. The "from pages"
option do not update directly the values you enter

GTK 3 problem ?

Works on windows (including CTRL+P). It is possible to

print but the dialog is not very intuitive Pass on 16.04 and 16.10

SequenceDiagram

... could it be cups giving you a hard time?
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5.27

Time Sync. without
interactions (Bug 391716)

1) Open trace without any sequence diagram
information

2) Open SD view if necessary

3) Open Error Log view if necessary

4) change time range in Histogram view

5) Change time current selected time in Histogram
View

Make sure that no exceptions
occurred

Manual

Can not open SD view but there is no error

SequenceDiagram
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Section
Tracing RCP

Target: Windows

Step
0

1
1.1

1.2

1.3

14

1.5

1.6

1.7

1.8

N

21

25

Test Case
Preparation

Start RCP

Start Tracing RCP

Start Tracing RCP with text
trace

Start Tracing RCP with
previously opened text trace

Start Tracing RCP with Kernel

CTF trace
Start Tracing RCP with

Pass
32

Tested using ExampleCustomTxt.log in traces.zip

Action

Open RCP from command line or file explorer

Open RCP from command line with --open <trace name with
absolute path>

Open RCP from command line with --open <trace name with
absolute path>. Use same trace than 1.2

Open RCP from command line with --open <kernel trace name
with absolute path>

previously opened Kernel CTF Open RCP from command line with --open <kernel trace name

trace

Start Tracing RCP with new
trace with name conflict

Re-do 1.6

Start Tracing RCP with non-
trace file

File menu
Open Trace (File)
Open Trace (File) with

previously opened text trace

Open Trace (Directory)
Open Trace (Directory) with

with absolute path>. Use same trace than 1.4

Open RCP from command line with --open <trace name with

Fail

Verification

Tracing RCP opens in default perspective

Trace will be opened with auto-detected trace type

Verify that the same trace that was previously linked into the Traces folder
is opened and not a new trace entry is created

Tracing RCP is opened, the trace is linked to the Tracing project, the
kernel analysis trace type is selected and trace is opened.

Verify that the same trace that was previously linked into the Traces folder
is opened and not a new trace entry is created

Verify that a new trace is linked to the Tracing project and trace is

absolute path>, where the name of trace is the same than 1.2, but opened. Verify that the new trace name has a integer number a suffix

the trace is located at a different location on disk
Open RCP from command line with --open <kernel trace with

added.
Verify that a kernel trace is linked to the Tracing project, the kernel

absolute path>, where name of trace is the same than 1.4, but the analysis trace type is selected and trace is opened. Verify that the new

trace is located at a different location on disk

Open file that is not a trace

Use Menu "File -> Open Trace ..." In the file dialog select a text
trace and select open.

Use Menu "File -> Open Trace...". In the file dialog select a text
trace and select open. Use same trace than 2.1

Use "Menu File -> Open Trace ..." . In the file dialog select a file
of Kernel CTF trace directory and select open.
Use "Menu File -> Open Trace ..." . In the file dialog select a file

previously opened Kernel CTF of Kernel CTF trace directory and select open. Use same trace

trace
Open Trace File with name

conflict

Re-do 2.5

Open file

than 2.3

Use Menu "File -> Open Trace ..." In the file dialog select a text
trace and select open, where the name of trace is the same than
2.1, but the trace is located at a different location on disk

Use "Menu File -> Open Trace ..." . In the file dialog select a file

trace name has a integer number a suffix added.

Trace is imported (linked) however default icon (from Eclipse) is set

Trace will be opened with auto-detected trace type

Verify that the same trace that was previously linked into the Traces folder
is opened and not a new trace entry is created

Verify that the trace is linked to the Tracing project, the kernel analysis
trace type is selected and trace is opened.

Verify that the same trace that was previously linked into the Traces folder
is opened and not a new trace entry is created

Verify that the new trace is linked to the Tracing project and the trace is
opened. Verify that the new trace name has a integer number a suffix
added.

of Kernel CTF trace directory and select open, where the name of Verify that the kernel trace is linked to the Tracing project, the kernel

trace is the same than 2.3, but the trace is located at a different
location on disk

Open file that is not a trace

analysis trace type is selected and trace is opened. Verify that the new
trace name has a integer number a suffix added.

Trace is imported (linked) however default icon (from Eclipse) is set

Automated To Do Comments

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

7

Comment

RCP
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2.8
29

3.1

3.2

34

3.5

41

4.2

4.2

44

Restart
Exit

Window Menu
Open Perspective

Open View
Preferences

Save Perspective As

Reset Perspective

Help Menu
Help Contents
Help Contents (shortcut)

Install new Software

About

Version + Copyright

Content

TMF presence

LTTng presence

Network Tracing presence

OS Tracing Overview presence
BTF presence

Upgrade

Upgrade from previous release
Add-ons

Install Incubator Software

Use Menu File -> Restart
Use Menu File -> Exit

Use Menu Window -> Show Perspective -> Tracing Perspective
Use Menu Window -> Show View -> Select Tracing -> Sequence
Diagram

Use Menu Window -> Preferences

Make changes of perspective by moving views and use menu
Window -> Save Perspective As. Enter a perspective name and
select Ok

Make changes of perspective by moving views and use menu
Window -> Reset Perspective.

Use Menu -> Help -> Help Contents
Use key F1

Use Menu -> Help -> Install New Software... to install new Eclipse
feature

Use Menu -> Help -> About

Use Menu -> Help -> About -> Installation details

Open Tracing perspective

Open LTTng Kernel perspective and kernel trace

Open Network Tracing perspective and PCAP trace
Open OS Tracing Overview perspective and kernel trace
Open BTF trace

Use Help -> Check For Updates

Use Menu -> Tools -> Add-ons... to install incubator features (e.g.

Verify that RCP is restarted with the previously open perspective and trace
Tracing RCP exits

Tracing perspective is opened

Sequence diagram view is shown
Preferences dialog is shown

Perspective with new name is stored

After confirming the reset operation the perspective is reset to the default
layout.

Help content browser is opened. All Tracing related help is included
Help content browser is opened. All Tracing related help is included

Installation is successful

About dialog is opened all relevent information (e.g. version, copyright
years etc) is up-to-date and correct.

Go over all tracing features and plug-ins and verify that all have the correct
version and copyright years

Tracing perspective opens

LTTng Kernel perspective opens

Network Tracing perspective opens

OS Tracing Overview perspective opens

Trace type detected and event table has BTF columns

RCP is upgraded

Installation is successful and feature is available

Manual
Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

but it in executing cli parser:(0%)

564009.

HTTP 500 error
HTTP 500 error

How to know that they are correct?

How to know that they are correct?

Tested with 7.2

Resetting the perspective adds "Run" and
"Search" menus to the main menu. Bug

RCP
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Section
Trace Synchronization

Target: Windows

Step Test Case

0

0.2
0.3

-

1.1

1.2

1.3

1.4

1.5

1.6

Prerequisites

Import traces

Create experiment 1
Create experiment 2
View Management
Open Synchronization
View

Delete view

Open view

Open Experiment

Synchronize experiment

Pass
15

Action

Import the scp_dest and scp_src traces in

the synctraces.tar.gz file

Create an experiment containing those 2

traces

Create an experiment with any other trace

Use menu Window — Show View — Tracing

— Synchronization

Close the Synchronization View

Use menu Window — Show View — Tracing

— Synchronization

Open the experiment containing the 2

synchronizable traces

Right-click on the experiment and select

'Synchronize Traces'
1) Close Synchronization View

Open view when trace is 2) Load LTTng experiment

already loaded

Synchronize experiment

1.6.5 with constant offset

1.7

1.8

1.9

Open trace

Re-open experiment
Restart
Functionnalities
Open experiment 2

Go back to previous
experiment

Synchronize experiment

3) Open 'Synchronization' view

Try to offset a trace by a second

Open an Lttng Kernel trace

Open the experiment containing the 2

synchronized traces

Restart Eclipse

Open the experiment containing traces that

do not synchronize

Re-open the experiment with the
synchronizable traces

Right-click on the experiment and select

'Synchronize traces'

Fail

Verification

Verify that 'Synchronization'
view is shown
Synchronization' view is
removed from perspective
Synchronization' view is
displayed and remains empty
Verify that the view is still
empty

After a time, the view is
populated with synchronization
result that say 'accurate'. And
one of the original traces has
been replace by a trace with
the same name, but with an
at the end.

Verify that view is populated
with synchronization data from
currently opened experiment

Visually verify that a
synchronized trace is now
offsetted

Synchronization view is empty
View shows synchronization
data from the experiment
Verify that view is populated
with synchronization data from
experiment

Verify that the 'Synchronization'
view is empty

Verify that the 'Synchronization'
view contains the data from the
experiment

After the syncronization job
finishes, the synchronized
experiment is closed and
experiment 2 is selected. The
synchronization view is empty.

Automated To Do Comments

Type

Manual

Manual
Manual

Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

2

Comment

Download trace archive

from: https://secretaire.
dorsal.polymtl.
ca/~gbastien/traces/

The offset is set differently
everytime. In addition the
synchronization view is cleared
and never populated again even
when clearing the time offset.

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

TraceSynchronization

Simon: not sure what should be the result of this operation
Bernd: | think it is to add a manual time offset on top of the synchronisation
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CustomParsers

Section Pass Fail Automated To Do Comments
TMF - Custom Parsers 28 12 0 4
Target: Windows

Step Test Case Action Verification Type Comment

0 Prerequisites

Find text and XML parser definitions in
Traces.zip/traces/customParsers and logs
0.1  Get custom parser definition and logs in /import Well tested with gerrit logs too!

1 View management
Open and reset Tracing perspective, and

1.1 Open perspective open Time Chart view Time Chart view opens. SWTBot Pass
Create a tracing project, open Manage  Custom parsers imported (TmfGeneric,

1.2 Import custom parser definitions Custom Parsers dialog and importtext  Custom XML Log) RCPTT Pass
Create a tracing project and import a text  Traces imported in Traces folder of project

1.3 Import custom traces and XML custom trace (ExampleCustomTxt.log, RCPTT Pass

2 Custom parser management
Open Manage Custom Parsers dialog in
2.1  Open Manage Custom Parsers dialog Traces folder context menu Dialog opens. SWTBot Pass

Select "Text" radio button, click New...
button, enter Trace type, change stuff,

2.2  New (text) click Next, click Finish Custom parser appears in list. SWTBot Pass
Select custom parser, click Edit..., change Previously entered data appears, can be

2.3 Edit (text) stuff, click Next, click Finish edited. SWTBot Pass
Select custom parser, click Export, enter

2.4  Export (text) name, click Save Exported custom parser stored in file system. RCPTT Pass

2.5 Delete (text) Select custom parser, click Delete Custom parser is deleted. SWTBot Pass
Click Import, find custom parser definition,

2.6 Import (text) click Open Imported custom parser appears in list. RCPTT Pass

Select "XML" radio button, click New...
button, enter Log Type, write an xml log in
the input,
<a><b><c>1</c><d>1</d></b><b><c>2</
c><d>1</d></b></a> then click on the
"feeling lucky" button. Set b to log entry,
set c to timestamp logged and d to
message logged, set timestamp format to

ss in both text boxes, click Next, click Automation
2.7  New (XML) Finish Custom parser appears in list. Manual Pass Candidate

Select custom parser, click Edit..., change Previously entered data appears, can be Automation
2.8  Edit (XML) stuff, click Next, click Finish edited. Manual Pass Candidate

Select custom parser, click Export, enter Automation
2.9  Export (XML) name, click Save Exported custom parser stored in file system. Manual Pass Candidate
2.10 Delete (XML) Select custom parser, click Delete Custom parser is deleted. SWTBot Pass
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2.1

3.1

3.2
3.3

3.4

3.5

3.6
3.7

3.8

4.1

4.2

4.3

4.4

4.5

4.6

Import (XML)
Custom parser trace handling
Select trace type (text)

Open trace (text)
Raw view (text)

Time synchronization (text)

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table

Select Event (Bug 457852)

Select Event using arrow keys
(457852)

Hide Raw viewer

Click Import, find custom parser definition,
click Open

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom Text
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw
Click in Time Chart view, select event in
editor table, select event in raw view
Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

1) Open Custom text trace

2) Right-click in table and select "Show
Raw"

Right-click in table and select "Hide

Table"

Right-click in raw viewer and select "Show
Table"

Select event in raw viewer

1) select event in raw viewer with mouse
2) use arrow key down and up several
times

Right-click in table and select "Hide Raw"

Imported custom parser appears in list.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Raw viewer is shown beside the events table

Events table is hidden and only raw viewer is
shown

Events table is shown beside raw viewer

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Raw viewer is hidden and only events table is
shown

Manual

RCPTT

Manual
Manual

Manual

RCPTT

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Or select the trace and verify the trace type in the
properties view

should this be in events editor?

This issue was resolved in 2015 but happened
again in 7.3. When you click on a raw event the
views are not synced on the first click. The
syncing only happens if you click on another raw
event, or triple click the initial event.

CustomParsers

Automation
Candidate
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FlameChartView

Section Pass Fail Automated To Do Comments
TMF - Flame Chart View 24 14 0 5
Target: Windows

Step Test Case Action Verification Type Comment
0  Download the test resources  Download this
1 Preparation
Use menu Window — Show View — Other ...
1.1 Open TMF Flame Chart View — Tracing — Flame Chart Verify that 'Flame Chart' view is shown SWTBot Pass
Import a trace that does not have any call Verify that nothing is shown in the view, except Automation
1.2 Import generic trace stack information, like a standard kernel trace  “Stack info not available (<tracename>)” Manual Pass Candidate
Import the trace in the "trace" directory of the  Verify that the Flame Chart View is populated
1.3 Import cyg-profile trace downloaded zip with some callstack information. SWTBot Pass
Import a trace in the "trace-fast" directory of Verify that the Flame Chart View is populated
1.4  Import cyg-profile-fast trace the downloaded zip with some callstack information. SWTBot Pass
2 Manage View
Automation
2.1 Delete view Close the Flame Chart View Flame Chart' view is removed from perspective Manual Pass Candidate
Use menu Window — Show View — Other ...
2.2 Open view — Tracing — Flame Chart Flame Chart' view is displayed and re-populated SWTBot Pass
Verify that view is populated with call stack
2.3  Open Trace Open "trace(-fast)" trace information SWTBot Pass
1) Close 'Flame Chart' view
2) Open "glxgears-cyg-profile(-fast)" trace
Open view when trace is already  located in the git in ctf test Verify that view is populated with call stack
24  loaded 3) Open 'Flame Chart' view information SWTBot Pass
Open Experiment with 2 or more Flame Chart
traces. Verify that view is populated with all call stack both traces can be seen in the table but the threads of the Automation
2.5 Open Experiment (You can use both traces) information (separated by trace). Manual Pass  |second trace are not visible Candidate
Select different trace by clicking its Events Automation
2.7  Select other trace editor tab View is updated to show selected trace. Manual Pass Candidate
Verify that view is populated with call stack from Automation
2.6 Restart Restart Eclipse with Flame Chart trace opened trace Manual Pass Candidate
Close traces and experiment one by one from Verify that Flame Chart view is cleared after Automation
2.7  Close all traces the editor tab closing the last trace Manual Pass Candidate
3 Navigation
Selected time line is updated. Table is updated to
show the full stack information at the selected
3.1 Select time Click on random time in the time graph pane  time. Selected time is updated in other views. SWTBot Pass
Previous or next call stack change is selected
and corresponding active function and stack
depth is selected. Table is updated to show the
3.2  Select Previous/Next Event Click Previous/Next Event button ffll_st??lf 'f_on_rT?t_"?TfE thei S_?E(ited_t"l]e SWTBot Pass
3.3 Zoom to function (table) Double-click on a function in the table pane Time range is updated to the full duration of the SWTBot Pass
3.4  Zoom to function (time graph) Double-click on a function (interval) in the time Time range is updated to the full duration of the SWTBot Pass
Automation
3.5 Go tofirst eventin trace Go to events editor, press home the Flame Chart view is updated Manual Pass Candidate
4 Synchronization
Selected time line is updated. Table is updated to
show the full stack information at the selected
4.1 Time synchronization Select a random time in another view time. If selected time is outside current range, SWTBot Pass
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4.2
4.3

5.1

5.2

6.1

6.2

Event synchronization
Time range synchronization

Function name import - Text file

Invalid text file import

Valid text file import

Function name import - CDT

Binary import

Binary import Ittng 2.8+

Select a call stack-impacting event (function
entry/exit) in events table
Select a new time range in Histogram view.

Open 'trace' from Fibonacci.zip. Click the
"Select a mapping file" button in the view and
click "Browse" to select a random .txt file that
does not contain any debugging info.

Import a file "fibonacci.symbols"

Click the "Select a binary file" button in the
view and click "Browse" to select the fibonacci
executable (fibonacci).

Open an Ittng 2.8+ trace with the executable
present

In addition to updating the selected time, the
active function at the event time is selected.

Time range is updated.

The function addresses do not change.

The view now displays function names instead of
function addresses (both in the timegraph and
the call stack areas).

The view now displays the function names for
both traces

The view now displays the function names for the
trace

SWTBot
SWTBot

Manual

SWTBot

Manual

Manual

FlameChartView

Kyrollos: Do you mean the button of configuration in the flame
chart view?

Not clear how to do this. There is no button "Select a binary file"

Kyrollos: +1

Which trace exactly, from where?
Bernd: Trace needs to be clarified
Kyrollos: Which trace?

Automation
Candidate
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Section
TMF - Events Editor

Target: Windows

Step Test Case

1
1.1

N

w

IS

41

4.3
4.4
4.5

[3,]

Preparation

Preparation step 1
Trace bookmarks
Experiment bookmarks

Filter

Filter

Cancel filter

Un-filter

Filter & Search

Search & Filter

Time Synchronization
Mouse synchronization
Key synchronization
Search synchronization
External synchronization
Range selection

Event Synchronization

Open trace

Mouse synchronization

Key synchronization

Search synchronization

External synchronization

Source Code / Model Lookup

Pass

Action

Open and reset LTTng Kernel perspective
Moved to sheet "BookmarksView"

Moved to sheet "BookmarksView"

In the header row, enter some regex and press Ctrl+Enter

Fail

Verification

LTTng Kernel perspective opens with correct views.

Only events matching regex are displayed. Top and bottom filter status
rows update while filtering is ongoing. When filtering is done, status
rows show number of matching events.

In the header row, enter some regex and press Ctrl+Enter, then Only some events matching regex are displayed. Status rows show

quickly press ESC before filtering is done

In the header bar, click the icon to delete a filter
In the filter bar, enter some regex; likewise in the search bar
In the search bar, enter some regex; likewise in the filter bar

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with
Enter/Shift-Enter

In any other view that supports time synchronization, select a
time.

Select an event with left button, press shift key and click to
select another event

Open an LTTng CTF Kernel trace

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with
Enter/Shift-Enter

In any other view that supports time synchronization, select a
time. The selected event in the editor is updated. Then give
focus back to the editor.

partial number of matching events, with different 'stop' icon.

All events are displayed. Selected event remains selected and visible.
Status rows are removed.

Events are filtered and highlighted accordingly

Events are filtered and highlighted accordingly

Other views are synchronized to the selected event's time
Other views are synchronized to the selected event's time
Other views are synchronized to the selected event's time
The first event at or following the selected time is selected and visible.

Range of events are highlighted. Selection range is updated in other
views that support range selection

Verify that an editor is opened showing LTTng Kernel specific columns.

Views are updated with the new trace.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

EventsEditor

Automated To Do Comments

Type

SWTBot Pass

SWTBot

Manual

SWTBot

SWTBot
SWTBot

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

8

Comment

Automation
Histogram and Properties. Candidate

Automation
Histogram and Properties. Candidate

Automation
Histogram and Properties. Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

| expected that the properties window will be
updated automatically without refocusing in
the events table. Hoang: Properties view not
updated
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7.2

7.3

7.4

8.1

8.2

8.3

9.1

8.2

8.3

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Unzip traces/c_project_callsite.zip and traces/callsite.zip

to your local disk.

3) Import demo C project to the Eclipse workspace of zip

file c_project_callsite.zip

4) Import the test trace of zip file callsite.zip to a tracing

project.

5) Select trace type "Generic CTF Trace" and open the

Preparation trace.

1) select event in table

2) click right mouse button
Open call site )
) Close source code project
) select event in table
) click right mouse button
)
)
)
)

3
1
2
3
Open call site (no source code) 4
1
2) click right mouse button
3

Open model URI

Export to text

Open a CTF trace (e.g. LTTng Kernel)

Click right mouse button

Select "Export To Text" menu item

Enter a file name and location

Export CTF trace Press OK

Open a trace other than CTF trace

Click right mouse button

Enter a file name and location

Export Other Trace Press OK

Open a CTF trace (e.g. LTTng Kernel)

Click right mouse button

Select "Copy to Clipboard" menu item

Copy to clipboard Paste it in a text file
Swap Columns and Change Fonts
1) Open a trace
Swap columns in events table 2) Drag a column
1) Open the preferences
2) select new font for trace types
3) press apply
Change fonts 4) verify that the font changed
1) Open the preferences
2) Reset the font settings
3) Press apply
4)

Reset fonts verify that the font changed

select "Open Source Code" menu item

select "Open Source Code" menu item
select event in table (e.g. 1st event)

select "Open Model Element" menu item

1
2)
3)
4)
5)
1)
2)
3) Select "Export To Text" menu item
4)
5)
1)
2)
3)
4)

Zip file(s) available under
https://drive.google.com/drive/folders/1DJ2FSYWi1u8HHfi2HWCtoAOKc

Verify that correct source code file and line number is opened
Since the source code is not available no source code file is opened.

Instead an error dialog is opened (with title "FileNotFoundException")

Since the model is not available the model element is not shown.
Instead an error dialog is opened (with title "FileNotFoundException")

Make sure that a progress monitor dialog is opened during the export.
After finishing make sure that the text file exists and it contains the
events stored in the file. Verify that the columns are printed as shown
in the events table and that they are separated by tab character.

Make sure that a progress monitor dialog is opened during the export.
After finishing make sure that the text file exists and it contains the
events stored in the file. Verify that the columns are printed as shown
in the events table and that they are separated by tab character.

Verify that the columns are printed as shown in the events table and

that they are separated by tab character.

Covered by SWTBot tests

Covered by SWTBot tests

Covered by SWTBot tests

Manual

Manual

Manual

Manual

SWTBot

Manual

SWTBot

SWTBot

SWTBot

SWTBot

can't see the optiobn of "Open Model
Element" unless | select the first event

no progress monitor dialog, only a job

https://cdn.vector.
com/cms/content/products/TA_Tool_Suite/Do
BTF_Specificai f

EventsEditor
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Section
XML Analysis

Target: Windows

Step Test Case

0
0.1

0.2

0.3

1.2

1.3

1.4

1.5
2

21

2.2

23
24

25
2.6

27
2.8
2.9

Prerequisites
Import traces

Get a test XML file

Make sure the XML file

Pass

Action

Import LTTng kernel traces

Download the test XML file here: https:
/Isecretaire.dorsal.polymtl.

ca/~gbastien/Xml4 Traces/Kernel.Linux.xml

Open the Manage Xml Analyses menu and delete
the XML file if it exists (or The XML files are
located in <workspace directory>/.metadata/.
plugins/org.eclipse.tracecompass.tmf.analysis.
xml.core/xml_files. Delete the linux kernel XML

does not exist in the project file if it exists.)

XML file handling

Verify analysis not present

Import XML file

Edit XML file

Disable XML file

Enable XML file
View management

Populate the views

In the project Explorer, expand any LTTng kernel
trace

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog import the
Kernel.Linux.xml file and close the dialog.
Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, select Kernel.
Linux and click Edit

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the
checkbox next to Kernel.Linux to disable it and
click Apply.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the
checkbox next to Kernel.Linux to enable it and
click Apply.

Open an LTTng kernel trace (eg trace2 from the
tracecompass-test-traces repo)

Open the 'Xml Control Flow Double-click the "Xml Control Flow View' under

View'

Open another XML view

Close view

Open view when trace is
already loaded

Close traces

Open trace
Open another trace

Open LTTng Kernel trace
View selection

the analysis

Double-click the 'Xml Resources View' under the
analysis

Close both XML views

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace
Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table  Select an entry in the table

Select entry in time graph

Select an entry in the time graph (empty region)

Fail

Verification

NOTE: XML files haven't been updated to latest Kernel tracepoints and
syscall changes. So, they only work with trace LTTng 2.5 and older

Verify that there is no 'Xml kernel State System' analysis

Verify that the 'Xml kernel State System' analysis is now
present under an LTTng kernel trace

Verify that the XML editor opens. The editor should have
Design and Source sub-tabs

Verify that the 'Xml kernel State System' analysis doesn't
show anymore under the LTTng kernel trace

Verify that the 'Xml kernel State System' analysis is present
again under the LTTng kernel trace

The 'Xml kernel State System' analysis should have a +
next to it, expand it and there should be 2 views under it:
'Xml Control Flow View' and "Xml Resources View'

A view titled 'Xml Control Flow View' should open and it
should look quite similar to the Control Flow View

A view titled 'Xml Resources View' should open and it
should look quite similar to the Resources view's CPU
entries. Both XML views are opened.

The views are closed.

The view opens with the correct title and is correctly
populated.

The view is emptied.

The view is populated.
The view is emptied.

The view is populated.
Same entry is highlighted in time graph.

Same entry is highlighted in table. Selected time line is
updated. Other views are synchronized to selected time.

Automated To Do
10 0
Type
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comments
10

Comment

Needs an update we already ship XML by default with tracecompass.

this link doesn't work

SWTBot test uses different XML

XML

Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate
Automation
Candidate

Automation

Automation
Candidate
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2.3

4.1

4.2

4.3

4.4

4.5

4.6

4.7

4.8

4.9

4.10

4.1

5.1

5.2

54

5.4

6.1

6.2

6.3

Select state in time graph
Mouse handling

Select a state in the time graph

Drag move time graph left and right with middle

Drag move time range button
Zoom time range (mouse
wheel) cursor inside time graph
Zoom time range (mouse

drag) button

Scroll with mouse wheel up and down, cursor

Mouse vertical scroll outside time graph

Vertical scroll bar Click and drag vertical scroll bar

Drag select time range
Double-click reset time

range Double-click left button on time scale
Mouse hover (empty
region) Hover mouse in time graph over empty region

Mouse hover (state)

Drag mouse selection

Click select with left button (begin time), press
shift key and click select another time (end time)

Shift key selection
Keyboard handling
Keyboard navigation in

table (entry selection) END keys

With focus on table,

in Windows use LEFT, RIGHT keys while parent

or child process is selected

Keyboard navigation in

table (tree expansion) process is selected

Keyboard navigation in time With focus on time graph, use UP, DOWN,

graph (process selection)
Keyboard navigation in time
graph (state selection)

Tool bar handling

HOME, END keys

Show Legend Click Show Legend button

Reset Time Scale Click Reset Time Scale button

Select Previous/Next Event Click Previous/Next Event button

Zoom with CTRL + mouse wheel up and down,

Drag in time graph scale left and right with left

Drag select time graph with right button

Hover mouse in time graph over state

Drag select time graph with left button

With focus on table, use UP, DOWN, HOME,

in Linux use press ENTER while parent or child

With focus on time graph, use LEFT, RIGHT keys

Same entry is highlighted in table. State is highlighted in
time graph. Selected time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is released,
states are updated and new time range is propagated to
other views.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, states are
updated and new time range is propagated to other views.
Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is
propagated to other views.

Table and time graph scroll up and down and remain
aligned. Selected entry does not change. Vertical scroll bar
updated.

Table and time graph scroll up and down and remain
aligned. Selected entry does not change.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, states are updated and new
time range is propagated to other views.

Time range is reset to full range, states are updated and
new time range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time,
end time, duration.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the first selected time, T2 the
second (draggged) selected time and delta the time
difference between T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the first selected time, T2 the
second (draggged) selected time and delta the time
difference between T2-T1 (can be negative)

Selected process is changed. Time graph selection is
updated. Vertical scroll bar updated.

For parent process, tree is expanded or collapsed. Time
graph item expansion is updated. Vertical scroll bar
updated. For child process, left changes selection to
parent, time graph selection is updated. Vertical scroll bar
updated.

Selected process is changed. Table selection is updated.
Vertical scroll bar updated.

Previous or next state is selected. Selected time is updated
in other views.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and
new time range is propagated to other views.

Previous or next state is selected. Selected time is updated
in other views.

Manual

SWTBot

Manual

SWTBot

Manual

Manual

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Could not do this test because the trace isn't big

| don't see any tree in XML view on macOS;

only in (non-XML) Control Flow.

Bernd: It might be that you have a kernel trace that doesn't contains
the event names defined in the xml. Different kernel version have
some subtle name differences. To be confirmed.

Hoang: On Windows, | pressed Enter on the parent and the tree is
expanded/collapsed. Left and right key does not select the
parent/child, instead selecting the next state of the child.

Kyrollos: Had to choose a state first. If an empty space was clicked
before let/right keys the selected event doesn't change

Kyrollos: Do you mean select next state change?

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

XML
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6.4

6.5
6.6

6.7

71

7.2

7.3

Select Previous/Next
Process

Zoom In/Out

Filter Dialog

Filter Processes
Synchronization

Time synchronization

Time range synchronization

Time range selection
synchronisation

Click Previous/Next interval button

Click Zoom In/Out button

Open Filter Dialog

1) Open Filter Dialog

2) Deselect several processes
3) Press Ok

Select a random time in another view
Select a new time range in Resources view or in
Histogram view.

In any other view that supports range
synchronization, select a new range.

Selected interval (process/resource) is changed in table
and time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to center of time
range. States are updated and new time range is
propagated to other views.

Verify that all buttons are working correctly

Verify that only selected entries are displayed in the view

Selected time line is updated. If selected time is outside
current range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is
updated to include it

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Hoang: No process, only intervals

Unable to fully test this case, see 5.2 above.

Kyrollos: When T2 is selected and if t2 is outside the time range.
Time range is updated to include it

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

XML
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Section
JUnit Tests

Target: Ubuntu 12.04 64 bit and on Hudson

Step Test Case

1
1.1
1.2
1.3
1.4
1.5
1.6
1.7
1.8
1.9
1.10
1.11
1.12
1.13
1.14
1.15
1.16
1.17
1.18

Junit Test Cases

CTF Core Tests Plug-in

CTF Parser Tests Plug-in

State System Core Tests Plug-in

TMF Core Tests Plug-in

TMF Ul Tests Plug-in

TMF Ul SWTBot Tests Plug-in

CTF Support for TMF SWTBot Tests Plug-in
TMF Xml Analysis Core Tests Plug-in

TMF Xml Analysis Ul Tests Plug-in

LTTng Control Core Tests Plug-in

LTTng Control Ul Tests Plug-in

LTTng Kernel Analysis Core Tests Plug-in

LTTng Kernel Analysis Ul Tests Plug-in

LTTng Kernel Ul SWTBot Tests Plug-in

LTTng Userspace Tracer Analysis Core Test Plug-in
LTTng Userspace Tracer Analysis Ul Test Plug-in
GDB Tracepoint Analysis Core Tests Plug-in
GDB Tracepoint Analysis Ul Tests Plug-in

Pass
18

Action

Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins

Fail

Verification

All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed
All test cases To Doed

To Do Comments

L 0 Jo

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

JUnits
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Section
LAMI

Target: Ubuntu 20.04.4 64 bit

Step Test Case

0
0.1

0.2

1

1.1
1.2

2.1

22

23

25
26

3.1
3.2
3.3

3.4
3.5
3.6

3.7

4.1
4.2
43

Prerequisites
Import traces

Download analysis stubs
Custom external
analysis

Add all stubs analysis
Actions available
Actions unavailable

Delete analysis

Run analysis
Reports

Reports node

Same name report

Delete node

Open a report

Open the same report again
Multiple report

Result Table
Prerequisites

Hide table

Show table

Sorting
Colum Resizing

Multiple selection

Unselect selection
Bar Chart

Create
Series dialog add
Series dialog remove

Pass

Action

any trace since we use stub for the result

https:/bugs.eclipse.org/bugs/attachment.cqi?id=263946

Create the following analysis ($name, $command):

analysisEmpty, analysisEmpty

analysisMultipleRow, analysisMultipleRow

analysisML imilarRow, i i imilarRow
analysisOneRow, analysisOneRow

multipleReports, multipleReports

invalidAnalysis, invalidAnalysis

errorResult, errorResult

clone, analysisOneRow

Right click on "External Analyses" node

Click the "add" action

Insert $name

Insert "fullpath/$executable" which is the full path to the stub executable.
ex: "ftmp/stub/stubAnalysis" where stubAnalysis is the stub executable
The path does NOT support ~ or relative path

Right click on a non-strikethrough custom analysis.
Right click on a strikethrough custom analysis.

Right click on the tuple (clone, invalidAnalysis)
Select the delete action for the node

Launch remaining analysis via righ-click and run action

Expand the "Reports" node under the Project Explorer

Execute the "analysisOneRow" analysis again.
Right click on the duplicate "analysis OneRow" node and click on the
delete action

Right click on any report and select the "open" action
Right click again on the same report to open it
Open the "multipleReports" report.

Open the "analysisMultipleRowReport"
Click the "Toggle" button in the right corner of the result table
Click the "Toggle" button in the right corner of the result table

Sort all column by clicking on the column name. Clicking multiple time on
the name should change the ordering sorter.

Resize the column

Select multiple rows by holding ctrl and clicking on multiple unselected
rows of the table

Deselect multiple rows by holding ctrl and clicking on multiple selected
rows of the table

Use the menu on the upper right of the result table and select "create bar

chart"
Select any x and any y click add
Remove all newly created series via the delete button

Fail

Verification

-from bug:
https://bugs.eclipse.org/bugs/show_bug.cgi?id=493941

All new external analysis are present under the "External Analysis" node in the Project explorer view.
All new elements do NOT have the strikethrough text style applied
EXCEPT for the tuple (invalidAnalysis, invalidAnalysis)

The run action can be clicked and in enabled text mode.
The run action CANNOT be clicked and is in disabled text mode.

The analysis does not appear in the list anymore.

analysisEmpty should return a message to the user regarding the emptiness of the report.
errorResult should return an error message to the user and display the result of the command.

All other one have result and should result in a new table and new report node under the report node.

The "Reports" node under the Project Explorer should contain 4 reports:
analysisMultipleRow Report

analysisMultipleSimilarRow Report

analysisOneRow Report

multipleReports

An additional node should be present under the "Reports” node:
analysisOneRow Report #2

Note: This behaviour is subject to change in the following year but still an action will be taken on same
name report creation.

The report node is not present anymore

A new panel should open with the result table of the analysis

A new panel should open with the result table of the analysis

Validate that a user is able to navigate between sub tab of a report

The result table is hidden
The result table is shown

Validate that the order make sense
Validate that the resize works
Multiple selections are highlighted in the table

The clicked row should not be selected anymore

Note: a bar chart does NOT perform agregation of categories values
Series are added to the series list
User should be able to delete series

LAMI

Automated To Do Comments

Manual

Manual

Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual

Manual
Manual
Manual

Manual
Manual
Manual

Manual

Manual
Manual
Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

16

Comment

Kyrollos: | had to open the trace to be able to see the external analysis

https://bugs.eclipse.org/bugs/show_bug.cgi?id=498218
Kyrollos: if the
trace is opened, |
had to manually
close the opened
trace and reopen it
to see that the
external analysis
that was deleted is
not in the external

https:/bugs.eclipse.org/bugs/show_bug.cqi?id=543800 analysis list

launching an analysis on a closed trace doesn't do anything

"multipleReports" is displayed "multipleReports Report" in Report

Waker and Wakee process name sorting is confusing: "Xorg" is sorted
lower than "compiz", which is sorted lower than "rcu_sched".
Kyrollos: Not sure about the Wakee process name sorting

Command key on macOS.

Command key on macOS.
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4.4

4.5
4.6

4.7

4.8

4.9

4.10

5.1

5.2
5.3

5.4

5.6
57

Creat chart

Selection
Multi selection

Deselection

Y axis

Keep the chart open

Hide the table results
Scatter Chart

Create

Creat chart
Selection

Multi selection
Deselection
Mouse hovering
Full deselection

Select any x and y and click add and "ok"

Click on any bar inside the chart
Ctrl+click on other unselected bar

Ctrl+click on other selected bar

Recreate the same graph but with the y log scale option enabled

Keep the chart open

Hide the table results

Use the menu on the upper right of the result table and select "create
scatter chart"

Select any x and y and click add and "ok"
Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart
Should be the same behaviour as the bar chart
Hover mouse in the graph

Click in the chart when no hovering cross is present

Abar chart should be created

Note: a bar chart does NOT perform agregation of categories values Manual
The corresponding row should be selected in the table and the chart should highlight the selected bar Manual
Selections should be highlighted in the result table and the chart Manual
The clicked bar should be removed from selection and the result table update with the current selections Manual
Y axis should be in log scale mode
Note: check for zero value and negative handling since log scale does not support zero and negative Manual
Manual
Manual
Manual
A scatter chart should be created
Manual
Should be the same behaviour as the bar chart Manual
Should be the same behaviour as the bar chart Manual
Should be the same behaviour as the bar chart Manual
On mouse hovering a cross should snap to the nearest point Manual
Al selected objects should be deselected Manual

LAMI

| selected Wakee Process TID as X axis, but TID is not displayed well
because of the sheer number of TIDs.

Kyrollos: Even when the chart is exported the TIDs aren't visible

When there are too much bars inside the chart it is more difficult to click on
abar.

Kyrollos:
Sometimes it is
difficult to select an
entry from the bar
chart specially
when you have lots
of bars but | can
deselect the bars
and it worked on
https://bugs.eclipse.org/bugs/show_bug.cgi?id=579392 Linux

When checking logarithmic scale Y, all y that do not support logarithmic

scale Y are not removed. When a Y is selected, all y that do not support

logarithmic scale Y are removed.

Marco for 7.3: don't know where to find negative or null value samples.

Kyrollos: | can't test with y negative values | don't know where to find

possible samples for such case

And? (Run the next step | presume; refactor?)

Kyrollos: What is the expected result? The chart is still open and can

create another custom views next to the chart?

Expecting what? (Toggling so the chart keeps showing | presume.)

Kyrollos: When toogle button is clicked the table is hidden and when it is

ckicked again the table appears and the chart is resized. | presume that it

is the expected output. To be confirmed

Kyrollos: When entries are selected from scatter chart, the selected entries
are selected in the table but when | toogle to hide the table and show it
again, the selected entries are no more selected in thetable

https://bugs.eclipse.org/bugs/show_bug.cgi?id=579392
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Target:

Section
GDB Tracing

Step Test Case

1
1.1
1.2

2
21
2.2
23

3.1
3.2
3.3

4.2

4.3

6.2
6.3

Preparation

Step 1

Step 2

Project Creation

New Project Wizard
Create project

Project structure

Traces Folder

Traces Folder menu
Trace Import Wizard
Import traces

Trace Configuration
Project/executable selection
Select Trace Executable
Open configured trace
Source Code Lookup
Select event

Select another event
Events Table Navigation
Arrow keys

Scrolling
PgUp/PgDn

Pass

Action

Open and reset the GDB Trace perspective
Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish
Close and open the new Tracing project

Select the Traces folder and open its context menu
Select Import Trace
Select a GDB Trace from samples directory and finish

Double-click on an un-configured trace

1) Right mouse click on trace

2) Select menu item "Select Trace Executable"
3) Fill in the proper values in dialog and finish
Double-click on a configured trace

With mouse select an event in events table

redo 5.1

Fail

Verification

GDB Trace perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer
Project contains the Traces folder

Correct menu opens (Open Trace, Import, New

Trace Import Wizard appears
Imported traces appear in Folders with proper

Verify that an Error Dialog opens that noffiies the
user to select the trace executable

Trace is configured (4.3 is successful, when 4.2
was successful)
Trace is opened, events table and views are

The corresponding source code location is
selected in the source code file.

The corresponding source code location is
selected in the source code file.

Each keystroke modifies the selected event and

Update the current event using up/down keys within wind the corresponding source code location is

Table is refreshed to display new current event
and the corresponding source code location is

Update the current event using up/down keys outside win selected in the source code file

Update the current event using PgUp/PgDn keys

Table is scrolled accordingly

GDB

Automated To Do Comments

15 0
Type
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass

6

Comment

Automate
Automate

Tested in base
class

Tested in base
class
Tested in base
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6.4

71
7.2
7.3
7.4
7.5
7.6

8.1
8.2

Home/End

Events Searching & Filtering
Search

Navigation

Un-search

Filter

Filter & Search

Un-filter

Events Synchronization
Synch from Events View
Synch from Trace Control

Table jumps from first to last event and the
Update the current event using Home/End keys corresponding source code location is selected

In the search bar, enter some RE Events corresponding to the RE are highlighted
Navigate through highlighted events using Enter/Shift-Eni Next/previous highlighted event selected

In the search bar, clear the RE Events are displayed normally

In the search bar, enter some RE and press Ctrl+Enter  Only events matching RE are displayed

In the filter bar, enter some RE; likewise in the search bar Events are filtered and highlighted accordingly
In the filter header, remove the filter Events are displayed normally

Click on an event in the Events View
Go up/down from the Trace Control View

Trace Control View is updated; Debug View is
Events View is updated accordingly

SWTBot

SWTBot
SWTBot
SWTBot
SWTBot
SWTBot
SWTBot

Manual
Manual

Tested in base
class

GDB
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Bug Reports

Section # Bug Reports # Open # Fixed
Bug Reports 11 6 4
Test Case Bug Title Bug Report Status

Drag and Drop from other Tracing project tmf: java.lang.Error: SWT Resource was not properly disposed for TmfPieChart when  https://bugs.eclipse.org/bugs/show_bug.cqi?id=576612 Open

Delete propagation Deleting last trace from Experiment also deletes that experiment https://bugs.eclipse.org/bugs/show_bug.cgi?id=579305 [Fixed Not a bug

Overwrite Yes-To-All in Trace Package Import wizard prompts again (behaves like Yes) https://bugs.eclipse.org/bugs/show_bug.cgi?id=579323 Open

Set invalid window span [TMF] Entering a window span of 1ns in Histogram View should be invalid https://bugs.eclipse.org/bugs/show_bug.cgi?id=550946 Open

Mouse synchronization (single time) Left-clicking on time chart first doesn't sync in editor and other views https://bugs.eclipse.org/bugs/show_bug.cqi?id=579357 |Fixed Not a bug

Filter cleared Clearing filter from editor doesn't update time chart view https://bugs.eclipse.org/bugs/show_bug.cqi?id=579358 |Fixed

Select Event using arrow keys (457852) [TMF] Event table raw viewer selection not propagated to Properties view https://bugs.eclipse.org/bugs/show_bug.cqgi?id=457852 None

Open Experiment Flame Graph symbol resolution does not work with experiment https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462 Open

Delete analysis [lami] Remove External Analysis does not refresh properly https://bugs.eclipse.org/bugs/show_bug.cgi?id=543800 Open

Actions unavailable [lami]: It is not possible to know why an analysis cannot be executed https://bugs.eclipse.org/bugs/show_bug.cgi?id=498218 |Fixed

Deselection [lami] Selecting an already selected bar in chart doesn't unselect it from chart or table https://bugs.eclipse.org/bugs/show_bug.cgi?id=579392 Open Deselection (other test)
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